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1
About This Guide

This section provides supporting information for the Oracle Data Foundation Cloud Services for
Banking (DFCS).

Audience

This document contains release information of Oracle Data Foundation Cloud Services for
Banking (DFCS).

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My
Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Resources

• Data Foundation for Banking

Conventions

The following text conventions are used in this document.

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which
you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code in
examples, text that appears on the screen, or text that you enter.
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2
Introduction to Data Foundation Cloud Service

The Oracle Financial Services Data Foundation Cloud Service (DFCS) for Banking offers a
consistent, efficient, and well-governed data management solution tailored to meet both
internal and regulatory data requirements for banks. It includes a comprehensive data catalog
designed to support key analytical use cases across finance, risk, and compliance domains.
This solution is powered by a feature-rich platform that enables data ingestion, data quality and
reconciliation, hosts high-quality historical data, and facilitates the distribution of validated data
through extraction routines and data visualization tools, such as reports.

Figure 2-1    Data Foundation

Oracle Data Foundation Cloud Service (DFCS) is a cloud-native data management and
processing platform that offers a single source of truth by using a unified and integrated results
area. The platform stages the data directly from the source systems, processes it, and delivers
results for downstream consumption.

Below are the salient features of the DFCS:

• Data Foundation prioritizes consistency in definition of data (and its governance) of a
financial institution by using an industry-leading ontology of business terms to model the
data.

• Data Foundation ensures transparency in data management processes by enforcing
Change Management at its core, leading to safer adaptability (extension) of its
comprehensive pre-built data model (and data catalog).

• Data Foundation provides an extensive Results Area that acts as the metaphorical
single-source-of-truth for all data needs of an organization across key functions, such as,
risk, finance, and compliance.

• Data Foundation also standardizes distribution of data to downstream applications and
use cases by providing certifiable interfaces for consumption.
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2.1 Organization of the User Guide
This user guide is divided into nine chapters. Chapters 2 through 7 focus on the core modules
of the Data Foundation Catalog.

1. Getting Started: This chapter outlines the process for ordering and configuring the Data
Foundation Cloud Service.

2. Data Catalog: This chapter details the structure and organization of the Data Catalog,
which outlines the data model for the Data Foundation.

3. Data Controls: This chapter covers the two types of data controls supported by the
service: Data Quality (DQ) and Reconciliation. It describes the structure of prepackaged
DQ rules and provides guidance on configuring and using these rules, along with the new
reconciliation rules.

4. Data Services: This chapter details the data integration features that support the sourcing
of data into the staging area and the extraction of data from the Data Foundation for
downstream consumption.

5. Data Operations: This chapter details various DFCS tasks that can be combined into a
sequence of data movement activities, including sourcing, curation, and consumption.

6. Data Visualization: This chapter is divided into two main sections:

• Data Browser: As DFCS is a SaaS service, users require a cloud-based data browser
to explore data. This section explains how to browse both source data and results
data.

• Pre-Built Reports and KPIs: DFCS is pre-configured with pre-built reports and KPIs.
This section provides guidance on using these examples for reference and
customization.

7. Change Management: All changes in DFSC are managed through a comprehensive
issue-mechanism. This chapter describes how to capture data events as issues and assign
appropriate actions for resolution to the respective action owners.

8. Key Terms and Concepts: This chapter defines the key terms and concepts used
throughout the User Guide.

9. Support: This chapter describes how to contact Oracle for support and clarification
requests.

Chapter 2
Organization of the User Guide
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3
Getting Started

The Oracle Financial Services Data Foundation Cloud Service (DFCS) for Banking provides a
consistent, efficient, and well-governed data management platform for internal as well as
regulatory/jurisdictional data needs of a bank. It comes with prebuilt data integration pipelines
and a comprehensive data catalog for well-known use cases of a bank.

3.1 Why DFCS?
Consider a bank with a diverse portfolio of products. They aim to accomplish the following two
primary data management objectives.

• Maintain a consistent view of data to meet regulatory obligations and support internal
performance measurement reporting.

• Reduce data sourcing costs by retrieving data once from a book-of-record system and
utilizing it across multiple downstream applications.

Suppose the bank encounters challenges in achieving these objectives:

• The data nomenclature used by regulatory agencies and internal use cases does not align
well with the terminology used in book-of-record systems.

• Each consuming application is developed independently, making it easier to source data
multiple times rather than achieving alignment across all consuming applications.

To address these challenges and achieve their data management objectives, the bank decides
to implement DFCS.

• DFCS offers a unified view of data sourced from book-of-record systems for all commonly
known consumption use cases in a bank. With DFCS, the bank only needs to source data
once, regardless of the number of downstream use cases currently in scope.

• A standardized set of quality-checked and reconciled datasets feeds into downstream
applications, ensuring consistent reporting for both regulatory and internal use cases.

3.2 Product Setup
To get started, you must activate the Data Foundation Cloud Service (DFCS). Refer to Oracle®
Financial Services Data Foundation Cloud Service for Banking Getting Started Guide.

3.3 Setting Up Your Service
This section provides the details on setting up Data Foundation Cloud Service (DFCS).

• Pre-deployment Processes

• Post-deployment Processes
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3.3.1 Pre-deployment Processes
The pre-deployment process requires selecting business domains, which determine deployed
data and metadata. Domains can be added later but cannot be removed once deployed. Extra
domains do not impact service usage.

• Domain

3.3.1.1 Domain
Domains represent business segments that you operate. The list of domains available with
your service will be listed for you to choose from. Your choice will determine data and metadata
artefacts that are deployed by the service for your use. You may choose one or more domains
and subsequently revise your choice with additional domains, as needed. You will not,
however, be allowed to drop domains once selected and deployed. Please note that additional
domains, even when chosen in error, will not adversely affect your usage of the service.

3.3.1.1.1 Select your Domain
This section helps you to select the business domain that aligns with your data deployment.
This will tailor the service to instantiate the right data structure for banking-specific needs.

1. In the Choose Domain page, select Banking to deploy.

2. Click Continue.

A confirmation message is displayed.

Note

• If you click Continue without selecting a domain, a warning message Please
select at least one domain. appears.

• Once you select a domain, the Continue button is enabled.

• By clicking Continue, the deployment process is initiated for the selected
domain.

• The system displays the deployment status, indicating progress and
completion.

3.3.1.1.2 Deploying the Domain
1. On the Deploy Domain page, the deployment steps, and the status of the deployment is

displayed.
The following is the list of steps initiated in the deployment process.

• Deploy Catalog: Deploys a physical instance of data structures based on the selected
Domains.

• Refresh Data Interface: Generates and deploys a logical abstraction layer to support
Data Services, following the specifications in the Catalog.

• Generate Data Quality Checks: Creates and deploys Data Quality assessment
routines as per the specifications in the Data Catalog.

• Deploy Dimension Rules: Deploys Dimensions required by the service, including
Slowly Changing Dimensions (SCDs).

Chapter 3
Setting Up Your Service
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• Reporting Object Registration: Registers reporting objects, enabling them to be
accessed and utilized within the reporting framework.

• Generate Data Connections: Deploys Data Services necessary for facilitating data
movement within the deployed data structures.

• Applying Redaction Policy: Implements data protection by applying redaction rules
to sensitive portions of the Catalog, including Personally Identifiable Information (PII).

• Generate Pipelines: Creates and deploys process definitions in the service’s Process
Management Framework to execute required functional tasks.

• Deploy Application Data Service: Deploys the data service layer required for
application-level interactions with the underlying data structures.

The following is the list of statuses displayed in the deployment process.

• Deployment Status Indicators: Each step is marked with a success, failure, or yet to
start status.

• Deployment Progress: The deployment status will change to Ongoing.

• Verify Deployment Status: Ensure that all deployment statuses are marked as
Completed.

2. Click Start Deployment to initiate the process.

3. Once the deployment is Successful, you will be automatically redirected to the login page.

Note

• If you are still logged in when the deployment is completed, you will be
redirected directly to the homepage.

• If you log out after triggering the deployment and log back in later, you will be
taken to the homepage.

• If the deployment is still in progress, you will be redirected to the deployment
page displaying the progress.

3.3.2 Post-deployment Processes
After the deployment process is complete, additional steps are required to ensure the domain-
specific configurations are fully functional and optimized.

1. After completing the pre-deployment steps, the admin must configure the following:

a. Legal Entity

b. Fiscal Period

c. Configure Parameters

2. To configure the above steps, navigate to the DFCS URL, and then click the User Menu >
Administration.
The system displays all the required configurations.

3.3.2.1 Legal Entity
The Legal Entity setup is used to define the reporting currency and specify the fiscal period for
posting entries. You can configure one or more Legal Entities for which the service maintains
the Management Ledger and performs related financial tasks.For each Legal Entity, a

Chapter 3
Setting Up Your Service
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Management Ledger is maintained to generate financial reports as part of the reporting
process. The service also supports a hierarchical structure of Legal Entities, enabling the
capture and organization of financial data accordingly.

• Legal Entity Settings

Note

Maximum levels supported for Legal Entity hierarchy in Balance reconciliation is 5.

3.3.2.1.1 Legal Entity Settings
The Legal Entity Settings allow you to define the reporting currency used for financial
transactions and reporting.

To set up the Reporting Currency, follow these steps:

1. To access Legal Entity Settings, go to the Home page, click Administration, and then
select Legal Entity.

The Legal Entity Settings page is displayed.

2. On the Legal Entity page, all available Legal Entities are listed on the left-hand side. To
configure the Reporting Currency and Fiscal Year for a specific Legal Entity, follow these
steps:

a. Select the required Legal Entity from the list (if available).

b. Set the fiscal period to open for posting entries by disabling or closed for posting
entries by enabling the Locked? option. An open posting period is when the selected
posting period is set to open and the other posting periods stay closed.

c. Set the Reporting Currency to the required standard. This Reporting Currency is
used during the Execution Process in Process Orchestration.

3. Click Save to save the Legal Entity settings.

3.3.2.2 Fiscal Period
The Fiscal Period Setup allows you to define the financial reporting periods for a specific
Legal Entity. It ensures all transactions are recorded within the correct accounting periods,
supporting accurate financial reporting and compliance with fiscal regulations.

• Set Up Fiscal Periods

• Compile Fiscal Periods

3.3.2.2.1 Set Up Fiscal Periods
Using this setup, you can:

• Add a new Fiscal Period to establish reporting timelines.

• Edit an existing Fiscal Period to update details such as start and end dates.
Open or close posting periods to control financial entries.

To add or edit a Fiscal Period, perform the following steps:
During deployment, an Administrator can set up Fiscal Periods using the procedure outlined
below. After deployment, Fiscal Periods can be managed from the Fiscal Period Settings
page. To access this page:

Chapter 3
Setting Up Your Service
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1. To navigate to the Fiscal Period Settings screen, on the Home page, click User Menu >
Administration > Fiscal Period.
The Fiscal Period Settings page is displayed.

Adding Fiscal Period

1. Click the Setup tab, the four built-in Fiscal Year Quarters are displayed: Quarter 1,
Quarter 2, Quarter 3, and Quarter 4.

2. Select the required quarter for a specific Legal Entity before proceeding.

3. Click Add Fiscal Period to add a new row in the Fiscal Periods list.

4. Double-click the Fiscal Period Name to edit and update it.

Note

The Fiscal Period Name and Quarter Name must contain 50 or lesser characters.

5. Double-click the Start Month field and select the required month (default: January).

6. Double-click the Start Day field and choose the appropriate start day.

7. Similarly, select the End Month and End Day values.

8. Verify these values across all quarters before proceeding.

9. Click Save to save the added fiscal period for the selected quarter.

Editing the Fiscal Period

1. Follow the above steps, and double-click on any of the field to edit the values.

2. Click Save to save the modified changes.

Deleting the Fiscal Period

1. To delete an existing Fiscal Period, click the corresponding Delete icon.
A confirmation message is displayed. Acknowledge the message.

Note

The Fiscal Periods set up in this Fiscal Period Module are associated with the
Legal Entity. This Fiscal Period Attribute is sourced as a part of the Legal Entity.

3.3.2.2.2 Compile Fiscal Periods
To assign a year or a fiscal year to the fiscal periods of the legal entity, use the Compile Fiscal
Periods process. During deployment, the administrator can set up Compile Fiscal Periods
using this procedure, or, after deployment.

To compile a set of fiscal periods for a year, perform the following steps:

1. To navigate to the Fiscal Period Settings screen, on the Home page, click on User Menu
> Administration > Fiscal Period.

The Fiscal Period Settings page is displayed.

2. Click the Compile tab.

Chapter 3
Setting Up Your Service
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Note

If the fiscal period added in the setup page does not match with the compile date
range, the system displays an error message Error occured while getting fiscal
periods.

3. Click Start Dateand choose the required start date.

4. Click End Date and choose the required end date.

Note

Once a start date has been compiled, you cannot load data for earlier dates.
Attempting to do so will result in a data ingestion failure due to partition
restrictions.

5. Click Compile to generate a date dimension and fiscal calendar for the selected date
range.

The selected date range is generated.

3.3.2.3 Configure Parameters
The Parameters are constant-value, run-time, or current-date variables intended for use with
DFCS. Apart from a seeded (predefined) set of System Parameters, you can add, modify, or
remove them as needed.

• Accessing Parameters

• Parameter Settings

• Defining a Parameter

• Modifying and Viewing a Parameter

• Deleting a Parameter

3.3.2.3.1 Accessing Parameters
To access the Parameters window, follow these steps.

1. To navigate to the Parameters screen, on the Home page, click on User Menu >
Administration > Parameters.

The Parameters Summary window is displayed.

2. Use the search option to search for a specific source.

3. Click Add to create a parameter. For more information, see Defining a Parameter section.

3.3.2.3.2 Parameter Settings
This section describes the parameter settings.

Chapter 3
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Table 3-1    Fields in the Parameters Window

Fields Description

Parameter Name The name for the placeholder that you want to
define. For example, MISDATE, which can be used
as a placeholder for Date.

Parameter Description The description for the parameter you want to
define. Example description: “MISDATE can be
used to substitute the date values for each day,
dynamically, in mmddyyyy format.”

Parameter Type There are three parameter data types:

• Constant is selected for substituting a
constant value.

• RunTimeis selected for substituting a value,
dynamically, in run time. In the example that is
used here, MISDATE can be selected as Run
Time because it is used to make a substitution
dynamically.

• CurrDate is selected for substituting a value
as Current System Date.

Value Applicable only for Constant data types. Holds the
actual value of the parameter.

3.3.2.3.3 Defining a Parameter
To define a new Parameter, follow these steps:

1. Click Add on the Parameters Summary screen.

2. Specify the information as described in the Parameter Settings section Parameter Settings.

3. Click Save.

3.3.2.3.4 Modifying and Viewing a Parameter
You can edit or view an existing parameter.

To edit or view a parameter, follow these steps:

1. Click the required parameter from the Parameters Summary screen.

2. Modify the name, description, type, value, default value or date format.

3. Click Save.

3.3.2.3.5 Deleting a Parameter
To delete an existing parameter, follow these steps:

1. On the Parameters Summary, click Delete corresponding to the parameter you want to
delete.

Confirm your action.

2. Click Yes to delete the Parameter.

Chapter 3
Setting Up Your Service
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Note

You cannot delete parameters in the following cases:

• If the parameter is used by any higher object. Example: Connector/EDD.

• If the parameter is pre-seeded.

3.4 DFCS Personas
The Data Foundation Cloud Service (DFCS) supports 3 types of user personas.

1. Business Analyst – Focused on data exploration and analysis.

2. Data Governance Analyst – Provides tools for data quality, compliance, and governance.

3. Administration – Manages system configurations, user access, and administrative tasks.

DFCS provides a tailored user interface for these personas. The landing page and available
menu options are dynamically adjusted according to the user's assigned group.

Each user group sees a customized dashboard and navigation menu, ensuring a role-specific
experience within the application.

Please refer to Identity Management User Guide for User Group and User Role Mapping.

The application also provides a Left-Hand Side (LHS) menu for all users irrespective of
personas. The menu options include Home, Data Catalog, Data Integration, Data Controls, and
Data Visualization.

3.4.1 Business Analyst
The Business Analyst in DFCS is to support data exploration and analysis. It provides tools
and functionalities that enable users to access, analyze, and visualize data efficiently.

3.4.1.1 Data Catalog - Line of Business (LOB)
Upon logging into the DFCS application, a Business Analyst is presented with a streamlined
interface tailored for efficient data exploration and issue tracking.

Landing Page Components

• Data Catalog View:

– Access Line of Business (LOB) and Subject Area views.

– Ability to view Entities and Ingress Connectors for data exploration.

• Data Browsing & Issue Logging:

– Browse Data with a dropdown option to refine searches in the Subject and Results
area.

– Log Issue directly from the home page for quick issue reporting.

• Task List & Issue Management:

– Displays the top 5 items from Issues & Actions, highlighting overdue tasks.

– Option to Review Issues directly from the home page without navigating to the inbox.

– View Inbox option for a full list of tasks and communications.

Chapter 3
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Table 3-2    Data Catalog – Line of Business (LOB): Landing Page Components

Menu Option Description

Source / Results Land on the OAS Home page

Log Issue Open Issues and Actions module

Review Open Issues and Actions module

View Issue Open Issues and Actions module

No. of Ingress Connectors Open Ingress connectors, no default filtration
available for now

Number of Entities Open Entities, no default filtration available for now

Note

The Task List displays only the five most recently updated items from Issues &
Actions, based on the latest available updates.
The View Inbox button below the task list, the Review button for each task item, and
the Log Issue button all redirect to the same page—Issues & Actions—functioning
similarly to an inbox. They do not navigate to any specific issue within Issues &
Actions.

3.4.2 DFCS Data Governance Analyst
Upon logging into the DFCS application, a Data Governance / Data Control User is
presented with a dashboard displaying key data quality and reconciliation metrics through pre-
built graphs.

Landing Page Components:

• Data Quality Monitor (DQ Monitor):

– Displays two graphs:

1. Data Error Ratio

2. Number of Records Failed vs. Scanned

– Clicking on the DQ Monitor graph redirects the user to the Data Visualization Report
for DQ Monitor.

– A Refresh Data button at the top right corner allows users to update the displayed
data.

• Reconciliation Difference:

– Displays two graphs:

1. Source and Target Balances

2. Negative and Positive Absolute Differences

– Clicking on the Reconciliation Difference graph redirects the user to the Data
Visualization Report for Reconciliation Difference.

– A Refresh Data button at the top right corner allows users to update the displayed
data.
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Figure 3-1    DFCS Data Governance Analyst User Interface

3.4.3 Administrator
Upon logging into the DFCS application, an Administrator User is presented with a Foldout
Menu and a Task List for efficient system management and oversight.

The following task list are available for easy navigation.

• Home: The user can view the dashboard/ homepage of the DFCS application.

• Inbox: It provides a centralized view of recent tasks, issues, and actions. You can log an
issue by clicking on Log Issue icon on the top right corner of the screen. It lists items with
key details such as status (e.g., New, Closed), type (Action or Issue), source (Catalog),
and timestamps for creation and modification. Users can search, select multiple items, log
new issues, and access item-specific options via the action menu.

• Refresh: Refreshes the current view or data on the page.

• User Menu: Displays username, privileges, Object Migration - Import and Export, Data
Management Interface, and About details.

1. Administration Privilege – Access to system administration features.

Note

This depends on the access privilege listed for the user.

2. Object Migration - Import – Import data objects into the system.

3. Object Migration - Export – Export data objects out of the system.

4. Data Management Interface – Likely opens a module for managing data operations.

5. About – Expandable option for viewing application or version details.

6. Sign Out – Logs the user out of the platform.

Landing Page Components:

• Foldout Menu:

– The welcome banner provides the user with a status that indicates the user session
currently Active and the last login date.

– Provides access to key administrative functions, including:

1. Data Catalog
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2. Data Services

3. Data Controls

4. Data Visualization

5. Task List

Table 3-3    Landing Page Components

Foldout Menu Item Sub menu options

Data Catalog – Business Terms
– Entities
– Catalogs
– Connectors
– Glossary Mapping

* Extend Data Catalog

Data Services – Data Source Templates
– Data Operations
– Data Extraction
– Connectors

* Add Data Source Templates
* Add Data Operations
* Add Data Extraction

* Add Connectors

Data Controls – Data Quality Check
– Data Quality Group
– Data Quality Exceptions
– Reconciliation Rules

* Add Reconciliation Rule
* Extend Data Quality

Data Visualizations – Source Data Visualization
– Results Data Visualization
– Data Quality Dashboard
– GL Reconciliation Dashboard
– Add New Visualization

* View Pre-built Reports

Task List The Task List (Top 5 Items) panel provides a quick overview
of the most relevant pending tasks assigned to the user.
– Displays the top 5 tasks based on relevance.
– Each entry includes:

* Priority Level (e.g., Medium, Low)
* Task Name (clickable link, e.g., test_doc_act)
* Due Date (all shown as "Due in 7 months")

Ask Oracle Click on the Ask Oracle icon at the botton-right corner to
enable users to navigate through various configuration and
data governance areas of the Oracle platform.

Note

The number displayed beneath the items in the Foldout menu denotes the
cumulative count of items available under that category.

Chapter 3
DFCS Personas

User Guide
G39682-03
Copyright © 2024, 2025, Oracle and/or its affiliates.

August 20, 2025
Page 11 of 11



4
Data Catalog

Data Foundation organizes metadata for the underlying data model using a shared glossary of
business terms and entities. By sharing business terms across entities, it ensures consistency
in physical data characteristics, such as data types and lengths. It also centralizes data
governance by automatically applying rules, like data quality standards, to any entity that uses
a field mapped to the business model.

4.1 Business Terms
The catalog acts as a central repository for Business Terms (BT), ensuring consistent
definitions for business concepts across the platform. It contains over 10,000 business terms
spanning more than 1,500 entities.

Each business term includes key attributes such as:

• Logical Data Type

• Element Type

• Seeded/ Custom Business Terms

• Originating Application

• PII Indicator (identifying if it contains Personally Identifiable Information)

Related business terms share a common definition while maintaining context-specific
relevance for different user roles, ensuring clarity and consistency across the organization.

4.1.1 Business Term Name
The Business Term Name serves as the standardized identifier for a Business Term within
the Data Catalog, ensuring uniformity and clarity across the application. It provides a
concise, human-readable representation that effectively captures the term's purpose and
meaning in a logical and structured format.

Key Characteristics:

• Standardized & Consistent – Ensures uniform terminology across systems.

• Clear & Readable – Designed for both technical and business stakeholders.

• Supports Data Traceability – Facilitates seamless mapping across diverse systems.

For example, a logical name like End of Period Balance clearly conveys its role and
relevance within financial reporting and analysis.

The naming conventions follow best practices, prioritizing clarity, scalability, and alignment
with the associated entity and attributes, ensuring effective communication and governance
across the data ecosystem.

4.1.2 Business Term Data Type
Data Types provide a framework for classification that defines the nature of data within a
system, ensuring proper interpretation, storage, and manipulation. Each logical data type is
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designed for specific use cases, clearly distinguishing how different types of data should be
handled. For instance, types like amount, amount_long, and amount_medium represent
financial figures with varying levels of precision and scale, while currency denotes monetary
values linked to a specific currency. These logical data types help maintain the structure,
integrity, and compatibility of data models across various systems and applications.

Following are some of the Data Types supported in DFCS:

Table 4-1    Mapping of logical data types to Oracle-specific data types

Logical Data Type Oracle Data Type

Amount NUMBER(22,3)

Date DATE

Flag CHAR(1)

Indicator VARCHAR2(1)

Rate_Percent NUMBER(11,6)

Code_Alphanumeric VARCHAR2(20)

4.1.3 Business Term Description
A Business Term Description provides a fundamental explanation of a Business Term, offering
a base definition that remains consistent and relevant across all contexts. It outlines the term's
core purpose and meaning, ensuring clarity and uniformity in its understanding and application.
This description serves as a common reference for stakeholders, connecting technical and
business perspectives while remaining independent of specific implementations or use cases.
For example, End of Period Balance could be defined as the account balance at the end of a
reporting period, reflecting a snapshot of financial standing. By delivering a universal and
context-neutral definition, the Business Term Description promotes clear communication,
traceability, and alignment with business objectives across various systems and processes.

4.1.4 Business Term References
Business Term References represent a comprehensive list of all entities within the data catalog
where a specific Business Term is used or mentioned. This includes the source and result
entities that store, process, or propagate the term, enabling complete traceability within the
data architecture. By documenting these references, stakeholders can track the flow and
usage of the term across various system tables, ensuring consistency and alignment. For
instance, the term End of Period Balance might appear in tables related to financial reporting,
account summaries, and transactional data. These references ensure that all data models
adhere to accurate term definitions and interpretations, promoting data integrity and
consistency.

4.1.5 Related Business Terms
Related Business Terms are variations of a core business term, each adapted to a specific
contextual meaning within different business processes or applications. While they share a
common foundational concept, their interpretation or usage may vary to address distinct
functional requirements. For example, "Country Code" might refer to a standardized ISO code
for global identification, whereas Regulatory Country could represent a jurisdiction-specific
classification used in compliance or regulatory reporting. Defining related business terms
ensures clarity and precision in data usage, fostering effective communication across diverse
teams and systems. This approach enhances traceability, minimizes ambiguity, and
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strengthens data governance by connecting related terms under a unified framework while
accommodating their contextual distinctions.

4.1.6 Business Term Contextual Descriptions
The Contextual Description offers application-specific definitions of a Business Term, tailored to
reflect its unique interpretation and usage within particular systems or domains. It
complements the universal Business Term Description by providing context that aligns with the
functional and technical requirements of each application. For instance, the term End of
Period Balance may refer to a customer's account balance at the close of a financial period in
a core banking application, while in the insurance domain, it could represent the balance
remaining on a policyholder’s account. These tailored definitions ensure clear communication,
promote accurate data usage, and ensure that the term’s meaning aligns with the operational
and analytical needs of each system. By providing targeted descriptions, the Contextual
Description helps bridge potential gaps in understanding and maintains consistency across
diverse applications.

4.1.7 Business Term Data Quality
Data Quality Rules establish the criteria and constraints necessary to ensure the accuracy,
consistency, completeness, and reliability of data associated with a Business Term. These
rules define validation checks, threshold limits, and compliance conditions that data must meet
to maintain its integrity across systems and processes. For example, for the term End of
Period Balance, data quality rules might include ensuring the value is non-negative, matches
the sum of debits and credits for a reporting period, and corresponds correctly to the
associated account type. These rules are applied at both the table and attribute levels in the
data model to detect anomalies, prevent errors, and ensure compliance with regulatory or
business standards. By implementing strong Data Quality Rules, organizations can uphold
data integrity, foster trust in their data assets, and enable accurate decision-making.

4.1.8 Business Term List of Values
The List of Values (LoV) for Business Terms consists of a predefined set of acceptable values
or categories associated with a specific Business Term. These values establish clear
boundaries for data entry, ensuring consistency, standardization, and accuracy across systems
and processes. For example, the Business Term might have a List of Values such as "Active,
Inactive, Closed, and Suspended. The LoV is typically managed in lookup tables within the
data model and plays a key role in validation, reporting, and analysis. By defining and
enforcing the List of Values, organizations can reduce errors, simplify data interpretation, and
ensure consistent application of the term across various operational and analytical contexts.

4.1.9 Business Term Use Case
The Business Term Use Case documents the specific applications of a Business Term across
various systems, illustrating how the term supports distinct business processes and analytical
needs. This mapping ensures that the term’s definition and usage align with the objectives of
each system. For example, the term End of Period Balance might be used in Profitability
applications to calculate income and expense margins, in Asset Liability Management to
evaluate balance sheet stability, and in Liquidity Risk management to assess cash flow
sufficiency. By outlining these use cases, the Business Term Use Case promotes accurate data
alignment across systems, facilitates seamless integration, and ensures the term is effectively
utilized to achieve both operational and strategic goals.
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Note

Once the term’s definition and usage are aligned with the intended objectives, you can
provide your comments, including any relevant details related to the definition.

4.2 Entities
Entity refers to a distinct and logically defined data object that represents a set of data in
banking operations. Entities are used to structure and organize data within a database or data
warehouse and are critical to maintaining consistency, traceability, and clarity in data
management. The entity contains business terms. The granularity of the entity is decided by
Primary Key which can be one or many business terms. The entity will hold the data from
various source systems or data within Data Foundation.

4.2.1 Line of Business
Data Catalog in DFCS provides comprehensive support for data for the following lines of
business.

• Retail and Personal Banking

• Wholesale Banking

• Investment Banking and Wealth Management

• Treasury

• Ancillary Lines of Business

It also has rich coverage for Reference and Market Data that are needed by the lines of
business.

Additionally, it supports a rich dimensional model for storing results for a comprehensive set of
use cases across Finance, Risk, and Compliance domains.

Table 4-2    Line of Business

Category Total No. of Entities

Retail and Personal Banking 64

Wholesale Banking 103

Investment Banking and Wealth
Management

68

Treasury Services 28

Ancillary Lines of Business 33

Reference and Market Data 799

4.2.1.1 Grain Classification
Data Catalog in DFCS provides the grain classification. Each grain can have one or more
entities. Grains represent the smallest, indivisible units of financial data that form the
foundation for processing and analyzing entities. These grains ensure granular-level detail and
traceability across various entities. Examples include entries such as Customer Account, which
identifies individual customer financial details, and Customer Account Transactions, which
record specific financial movements. Date serves as a temporal dimension for tracking
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transaction timelines, while Exchange Rates provide currency conversion details essential for
multi-currency operations. General Ledger Data consolidates financial information at the
account level for reporting and analysis, complemented by Management Ledger for managerial
insights. Other granular elements, such as Group Insurance Policy Beneficiary and Group
Insurance Summary, capture policy-specific details, while Policy Claim, Policy Claim
Transaction, and Policy Commission Transactions detail insurance operations. Finally, Party
Consent represents customer authorization for processing sensitive financial data. These
grains collectively create a robust and detailed framework for accurate and transparent
financial accounting.

Some of the examples for grain counts are Customer Accounts, General Ledger Data.

4.2.1.2 Entity Type Classifications
Entity type classification is a structured method for organizing entities based on their roles and
functionality within a data catalog. Each entity type plays a distinct role in ensuring seamless
data processing and analysis. Within this framework, the distribution emphasizes the
importance of each classifications:

• Dimension Results: These entities offer contextual and descriptive master data.

• Fact Results: These entities store transactional and quantitative data that serve as the
foundation for performance measurement and reporting.

• Point of Integration: These pivotal entities act as connectors, ensuring the smooth
exchange and alignment of data across different Apps.

• Processing: These entities handle computational logic and business operations,
transforming raw data into actionable insights.

• Staging: The most numerous, these entities store raw or intermediate data, playing a vital
role in validation, enrichment, and data transformation workflows.

This classification ensures each entity is effectively utilized for its specific function, fostering
efficiency and consistency in data-driven processes.

Table 4-3    List of Entity Type

Entity Type Count

Dimension Results 779

Fact Results 626

Point of Integration 8

Processing 14

Staging 1203

4.2.2 Product Processor Entities
The classification of financial products based on their processor categories and catalog entities
is crucial for organizing and managing data within financial systems. This systematic approach
categorizes various financial instruments and contracts across different domains, ensuring
accuracy and consistency. By organizing products into distinct categories such as assets,
derivatives, liabilities, and off-balance sheet assets, this classification helps improve data
accuracy, ensure regulatory compliance, and streamline reporting. Examples of such
classifications include assets like loan contracts, overdraft accounts, and investments;
derivatives like credit derivatives, swaps, and options; liabilities such as term deposits and
borrowings; and off-balance sheet assets like commitments and letters of credit. This
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structured framework supports consistent product processing, facilitates seamless integration
across financial systems, and ensures clarity in the representation of financial data.

Some of the core products of banking are:

• Loan Contracts

• Term Deposits

• Option Contracts

• Letter of Credit

4.2.3 Reference Data Entities
Reference data in a data catalog serves as a foundational component that standardizes and
contextualizes data across systems and processes. It represents relatively static datasets used
to provide consistency, alignment, and meaning in data-driven workflows. Examples of
reference data include Catalog Entity, which organizes and identifies key entities; Currency,
which defines monetary units for financial transactions; and Country, which standardizes
geographical identifiers. Additional reference data like Forecast Exchange Rate provides
predictive currency values essential for planning and analysis, while Macro Economic Variables
and Macro Economic Variable Details capture high-level economic indicators and their granular
components, respectively. By maintaining centralized, accurate, and easily accessible
reference data, the data catalog ensures reliability, fosters interoperability, and enhances the
integrity of analytics and reporting processes.

Some examples of the catalog entities are Currency, and Country.

4.2.4 Results Area Population
Data Foundation has ability to provide data for analytical applications in finance, risk, and
compliance domains. It also has well-designed placeholders to store results data from these
applications.

Key Features of the Results Area Design

• Design: The Reporting Area data model is a dimensional data model. This means that it
consists primarily of central fact tables (de-normalized), related to multiple dimension
tables, also called a Star Schema. Additionally, the dimension tables are shared across the
star schemas in the reporting mode, meaning they are Conformed Dimensions.

• Support for multiple scenarios of analysis: The reporting data model has been
designed to support scenario analysis of the sort required by financial institutions that need
to measure and report risk and performance under a variety of economic scenarios. The
reporting model provides support for this kind of analysis via a Run Dimension – it allows
analytical engines to load multiple result sets identified by scenarios.

• Support for Cross Functional Reporting: The third critical feature of the Reporting area
design is the support for cross-functional reporting. Majority of emerging needs relate to
the analytical problems at the intersection of the distinct areas of Risk, Performance,
Customer Insight, and Compliance. This is addressed amply by the results area of Data
Foundation.

4.3 Catalog Extensions
Extension of data catalog is carried out with due consideration for Change Management
through an Issue-Action Management feature. Final step of Change Management includes a
built-in administrator level oversight for publishing the catalog changes into actionable
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metadata as per a schedule that does not conflict with the data pipelines under execution. For
further information about how to browse and extend the Data Catalog, refer to the Oracle®
Data Foundation Cloud Service Data Catalog User Guide.
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5
Data Services

This section outlines how data is exchanged between the Financial Services Data Foundation
Cloud Service for Banking and external systems. This is achieved through the logical
abstraction of the Data Catalog, which is exposed as Application Data Interfaces (ADIs). Users
can define External Data Descriptors (EDDs) through the interface, enabling seamless
mapping of EDDs to ADIs and the creation of Connectors for efficient data services.

For more information, see Oracle® Financial Services Data Foundation Cloud Service for
Banking Data Services Guide.

5.1 Background and Coverage
Data Foundation comes pre-configured with capabilities for assimilating data for the following
products. Assimilated data will act as single source of truth for all product related data. Data
Foundation also supports extensions of the underlying platform to support unique needs of the
customer not available in the pre-configured version.

While customers are expected to setup sourcing of data using EDDs, Data Foundation ships
with pre-built results area connectors for the following products.

• Annuity Contracts

• Bill Contracts

• Borrowings

• Cards

• Casa (Current/Checking Accounts, Savings Accounts)

• Commitment Contracts

• Commodity Contracts

• Correspondent Accounts

• Credit Derivatives

• Forwards Contracts

• Futures Contracts

• Foreign Exchange Contracts

• Investments

• Letter Of Credit Contracts

• Leases Contracts

• Loan Contracts

• Merchant Cards

• Overdraft Accounts

• Option Contracts

• Payment Settlement Accounts
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• Prepaid Cards

• Repo Contracts

• Swaps Contracts

• Term Deposit Contracts

• Other Assets

• Custodial Accounts

• Trusts

• Trading Account

• Connectors for Islamic Banking products too are supported out-of-the-box.

– Ijarah Accounts

– Istisna Accounts

– Mudarbah Accounts

– Murabahah Accounts

– Musharkah Accounts

– Salam Accounts

– Sukuk Accounts

5.2 Data Sourcing
Data Sourcing refers to the processes of acquiring data from both internal and external
systems (data sourcing) and transferring it to other environments or applications. Data
sourcing involves identifying, extracting, and collecting data from various sources, such as
transactional systems, third-party providers, or data warehouses. This data is then processed
and integrated to support business operations, reporting, or analytics. In contrast, data egress
deals with the movement of processed data from its original system or database to other
platforms, systems, or end-users. This may include sharing data with downstream applications,
regulatory reporting systems, or external partners. Data sourcing must be carefully managed to
ensure data quality, security, and compliance with regulatory standards, particularly when
handling sensitive financial or customer information. Effective strategies for data sourcing is
vital to ensuring that the right data is delivered to the right destinations in a timely, secure, and
accurate manner. In DFCS, data sourcing is facilitated through Connectors using External Data
Descriptors for each entity.

For more information on External Data Descriptor and Connectors, see Data Services guide.

5.3 Application Data Services
Application Data Service (ADS) is a multi-tenant, microservices-based integration framework
that enables secure, automated data exchange between Oracle Cloud Infrastructure (OCI)
services. It facilitates seamless connectivity between Data Foundation and other OCI
applications, such as Profitability and Balance Sheet Management Cloud Service (PBSMCS),
by managing data flow and integration at scale.

ADS Provides pre-built components for execution and scheduling of data exchange jobs. For
more information, refer to Oracle® Financial Services Data Foundation Cloud Service for
Banking Data Services User Guide.
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6
Data Controls

Data Controls consists of a scalable, rule-based engine that uses a single-pass integration
process to standardize, match, and duplicate information across global data. This framework
within the infrastructure system facilitates you to define rules and execute them to query,
validate, and correct the transformed data existing in an Information Domain.

For more information, refer to Oracle® Financial Services Data Foundation Cloud Service for
Banking Data Controls User Guide.

6.1 DQ Checks
Data Quality Framework consists of a scalable rule-based engine that uses a single-pass
integration process to standardize, match, and duplicate information across global data. This
framework within the infrastructure system facilitates you to define rules and execute them to
query, validate, and correct the transformed data existing in an Information Domain.

Data Catalog Contents include Data Quality Check Rules and DQ Groups (logical grouping of
DQ rules). These Rules are defined at the Business Term and Entity Level, and seeded as a
part of the Data Catalog Content.

For instructions on how to create/edit/delete DQ rule, please refer to Oracle® Data Foundation
Cloud Service Data Catalog.

The following is a list of pre-configured Data Quality rules included in the offering:

In the banking domain, data quality is essential for ensuring the integrity, accuracy, and
reliability of financial information that supports decision-making, compliance, and operational
efficiency. To maintain high standards of data quality, various validation rules are applied to the
data. These rules help identify and prevent errors, inconsistencies, and incomplete data entries
that could lead to incorrect business processes or regulatory violations. Common data quality
rules used in banking include Prebuilt Business check, list of values, referential integrity
checks, range checks, and more. Below is an overview of these rules, along with examples
specific to the banking domain, which highlight their importance in managing data effectively
across banking systems.

Data Quality Rules Definition Example Objective

Prebuilt Business
Checks (Custom
Checks)

Prebuilt Business check
is a rule based on
business specific or
unique conditions that
don’t fall under standard
data quality rule
categories.

A customer's Account
Balance must not be
negative if the account
type is 'Savings'.

To apply business-
specific logic that isn't
captured by standard
validation rules.

List of Values or Code
Check

This rule ensures that a
field contains a value
from a predefined list of
valid values, such as
bank codes, account
types, or country codes.

The Account Type must
be one of the following:
'Checking', 'Savings',
'Credit".

To ensure only valid and
standardized data
entries are used in the
system.
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Data Quality Rules Definition Example Objective

Referential Integrity
Check

Ensures that
relationships between
different tables or data
entities are correct,
typically by checking
foreign keys against
primary keys.

The Loan ID in the
Payment History table
must exist in the Loan
Account table.

To prevent orphaned
records and ensure that
linked data entities are
consistent across the
system.

Column Reference or
Specific Value Check

Ensures that the value in
one column is consistent
with values in another
column or a related data
set.

If the Account Status is
'Closed', then the
AccountBalance must be
zero.

To ensure that business
logic between columns is
followed correctly.

Generic Check A general validation
check applied across
various data sets, such
as length checks or
format checks, which
doesn’t belong to a
specific category.

The IBAN number
should be 22 characters
long and contain only
alphanumeric
characters.

To apply basic checks
that are common across
different data sets.

NULL Value Check Verifies that required
fields are not missing,
meaning they are not
NULL.

The Customer Name
field must not be NULL
for all active customer
records.

To ensure that essential
customer or transaction
information is always
captured.

Data Length Check

Duplicity Check

Range Check Verifies that data values
fall within a valid range,
which is commonly used
for numeric fields or
dates in banking
systems.

The Credit Score must
be between 300 and
850.

To ensure that data,
such as credit scores or
loan amounts, falls within
realistic and acceptable
ranges.

BLANK Value Check Ensures that fields do
not contain blank or
empty string values,
which may represent
missing or incomplete
data.

The Loan Amount field
must not be blank or
contain only spaces in a
loan application.

To prevent incomplete
data from being entered
into critical banking
systems, ensuring full
and valid records.

These banking-specific examples help ensure that critical financial data is correct, consistent,
and adheres to industry standards for data integrity and compliance.

In DFCS the following number of rules are bundled /autogenerated in each category.

Table 6-1    Number of Tools that are bundled

Check Type No of Rules

Prebuilt Business Checks 807

List of Values or Code Check 3270

Referential Integrity Check 7612

Column Reference or Specific Value Check 338

Generic Check 262

NULL Value Check 279

Range Check 11
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Table 6-1    (Cont.) Number of Tools that are bundled

Check Type No of Rules

Duplicate Check 0

Data Length Check 0

BLANK Value Check 6

6.2 Balance Reconciliation
Balance Reconciliation reconciles the balances from the operational systems of a bank with
the balances maintained in General Ledger (GL) of the bank. The bank's operational data are
sourced into standard product processor entities or other operational data entities used by the
bank.

The balances in the GL of a bank are the ones that are audited and duly certified by internal
and external auditors. Hence, considered to be the final version of the truth in a bank.
Therefore, all data extracted from any other operating system of a bank must be reconciled
with the balances maintained in the GL to ensure they are complete, accurate, and
comprehensive. It acts as an authentic and reliable base for any further decision-making.

DFCS' GL Reconciliation has pre-configured definition process. Currently DFCS supports
below type of reconciliation:

• General Ledger to Product Processor

Note

For more information on Balance Reconciliation, see Balance Reconciliation in the
Data Controls user guide.
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7
Data Operations

Process Orchestration is a design and execution service that enables process pipeline
developers to implement pipelines modeled by business analysts. Process pipeline developers
use this framework to orchestrate Run Pipelines within DFCS, and also to design the artifacts
that are used in the pipelines.

The Process Modeller and the Process Monitor are two key parts of Process Orchestration.
The Process Modeller is used to model pipelines. It aids in representing the various artifacts
required for modeling and provides implementation details of the DFCS process artifacts. The
Process Monitor is used to monitor instantiated pipelines of DFCS.

Please refer to Data Operations User Guide to learn about navigating Process Modeller and
the Process Monitor interfaces.

This section also describes a user data entry interface for managing reference or master data
entities. DFCS-specific pre-built process components included in the process modeler are
detailed at the end of the chapter, while other pre-built process components are covered in the 
Oracle® Financial Services Data Foundation Cloud Service for Banking Data Operations User
Guide.

7.1 Uploading Data Files for Ingestion
The file operation process enables you to add files that must be processed to the object store.
You can upload any CSV, XLSX, and Text file that you wish to be stored in the object store,
which can be processed later.

To upload a file, complete the following steps:

1. On the DFCS home page, click the User Menu and select Administration.

2. Click File Operations.

3. Click Upload File.

The Generate PAR URL to upload file window is displayed.

4. Enter the File Name.

5. Select the File Type from the drop-down list.

The supported file types are: CSV, XLSX, Text, and Zip.

6. Enter the file size (in bytes) as seen on the disk.

Note

Enter a number between 0 and 8,053,063,681. The input should be no more than
255 characters. Ensure the value matches the following format: '[a-zA-Z0-9][a-zA-
Z0-9.-_:]*[a-zA-Z0-9]'.

7. Click Add to add more files, and repeat the steps.

8. Click Delete to remove files.
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9. Click Generate.

This generates a PAR (pre-authenticated request) URL which is valid for 24 hours. This
PAR URL is used to upload the file into the object store.

10. An entry for the PAR URL you just created appears on the File Operations page.

The search feature provides you multiple options to search for a file based on name,
creation date, and so on. You can also sort the list by name and creation date in ascending
or descending order.
You can download a file using REST API.

7.2 Data Maintenance Interface
Data Maintenance Interface (DMI) helps to design a Data Form in a user-specified format.
Further, it allows performing data entry-type actions using the Designed Form.

The Form Builder within the Data Management Interface (DMI) provides users with the
capability to design and configure custom forms tailored to data-related activities. These forms
serve two primary purposes:

• Data Entry: To enable manual input of data into structured formats.

• Excel Upload: To allow users to upload datasets in bulk using Excel files.

The Data Management Interface (DMI) facilitates a structured workflow for creating,
authorizing, and using forms to manage data input. The process consists of the following key
stages:

• Form Creation: A user initiates the process by creating a form using the Data Entry or
Excel Upload. This form includes configurations such as entities, attributes.

• Form Authorization: Once the form is created, it must be reviewed and authorized by a
user with authorization privileges. This step ensures the form complies with data
standards and access controls.

• Form Activation: Upon approval, the form is marked as Authorized.

• Data Entry: Users can now enter data using the authorized forms. The inputted data is
then captured and stored in the database.

Note

Authorized Forms are the central point of control, ensuring only approved data
structures are used. The process enforces data governance by involving validation
and authorization steps before data input. Supports both manual entry and bulk
upload depending on the form type.
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Figure 7-1    DMI Process Flowchart

Refer to the Identity Management User Guide for details on user roles and their
descriptions, which define the permissions required to perform the actions described
above.

7.2.1 Configuring Data Maintenance Forms
You can create forms from the Form Designer View. The forms in the application are created
with details configured for data maintenance and require authorization for use after creation.
You can also edit, view, and delete forms, from the Forms Definitions Summary, based on the
assigned roles and privileges. For more information, refer To access the Data Maintenance
Interface (DMI):

1. Login to your Oracle Cloud account, with the required credentials to access DMI.

2. Select the Profile button and click on Data Maintenance Interfaceto display the Forms
Definition - Summary page. This section enables users to create and manage custom
forms for data operations. It provides a summary of all existing DMI forms and an option to
add new ones.

Note

The navigation steps vary for different applications. Refer to the respective
application documentation for accessing Data Maintenance Interface.

3. The following details are included the Summary page.

• Name - The unique name of the Form Definition

• Description - The Form Definition description.

• Type - The form definition type:

– Excel Upload – creates form based on uploaded Excel Sheet.
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Note

Make sure the Excel files are saved in the Microsoft Office 2016 Standard
version. Excel files saved in Office 365 version cause compatibility issues.

– Data Exporter – creates form based on an entity table.

– Data Entry – creates the form based on the entities, attributes and rulesets
provided by the user.

• Status - The processing status of the form definition. The various processing statuses
are:

– Draft – when the form is under development and is yet to be submitted for
approval.

– Pending Approval – When the approval is pending.

– Approved – When the form definition is approved.

• Created By - The Username of the logged in User who created the form.

• Actions - View, copy or edit or amend a form definition.

• Info - The form definition details including:

– Created Date

– Last Modified By

– Authorizer

– Authorizer comments

Use Search to quickly access the required forms or check the Forms tile to view a list of
existing forms. To search for a specific Form Definition, input search terms in the Form
Name or Description field, or use a combination of both, and click Search. Click Cancel
to clear the search criteria and view all form records.

Sort the Form Definition based on Name, Description, and Created By fields. You can
also sort the page in ascending/descending order.

To filter and view Form definitions with a specific processing status, click the respective
status name at the top of the page.

7.2.2 Creating New Form
Form creation involves selecting entities, displaying columns with attributes on the form, and if
required, selecting authorization of data. Security settings provide for the creation of specific-
user access for the forms and authorization.

1. In the Data Maintenance Interface page, click Add, to access the Create Forms
Definition page.

Opens the Designer - Configure screen.

2. Enter the following details.

• Excel Upload – creates form based on uploaded Excel sheet. For bulk uploads via
spreadsheet.

• Data Entry – creates the form based on the entities, attributes and rulesets provided
by the user. For manual data input.

• Code: Auto-generated.
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• Name: Enter the form name.

• Description: Provide a short explanation of the form's purpose.

Note

For more information about creating various form definitions:

• Configuring Data Entry

• Configuring Excel Upload

7.2.2.1 Configuring Data Entry
Use the Data Entry option to create a Forms Definition and select the table and attributes that
you want to modify.

You can enter the values for the table records in the approved Forms Definition from Data
Entry, after the new Forms Definition is approved from the Forms Definition Summary Page.

To configure the Data Entry definition, enter the details in the following sequence.

• Details

• Entities

• Attributes

• Ruleset

• User Security

1. Select Data Entry in Create New Form Definition page and enter the required details.

2. Enter the following details:

• Code - Unique form code. This value is auto-generated.

• Name - Enter the name. You can enter between 3 to 100 characters. Only alphabets,
numbers, spaces, and underscores are allowed.

• Description - Enter the form description. You can enter between 3 to 100 characters.
Only alphabets, numbers, spaces, and underscores are allowed.

3. Click Continue to access the Entities tab or Save to store as draft.

4. Once the form is updated, click Submit if you want to submit the Forms Definition for
manual/auto approval.

7.2.2.1.1 Entities
In the Entities tab, you can associate an entity with the form. An entity typically represents a
data object or database table where the data entered through the form will be stored.

1. In the Entity search box, enter an entity name and select from a list of predefined entities.
The key icon signifies that the entity is a primary reference for data mapping.

2. Click Continue, to proceed with the Attributes tab.

7.2.2.1.2 Attribute
This step allows users to define which data attributes (fields) from the selected entity will be
included in the form. These attributes form the actual input fields visible to the end-user.
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1. Select the Filter from the existing filters in the drop-down list or click Filter to define a new
one for the form definition. The use of Filters is optional.

Filter Condition: Enables conditional filtering of entity attributes to display only relevant
fields.

• Click the filter icon to open the Expression Builder.

Filter Condition Builder (Pop-up): This builder helps you create logic to filter attributes
based on values.

• Select Columns: Pick an attribute to filter on.

• Condition: Choose a logical operator (e.g., equals, contains).

• Filter Value: Define the specific value to match.

• Use the Validate button to test your expression.

• Click Apply to activate the filter and return to the attributes list.

Note

If no columns are available, it means no entity was selected or the entity has
no attributes mapped.

Table 7-1    Attribute Grid Columns

Field Description

Entity Name The name of the associated entity.

Source Attribute Name The actual field name from the entity.

Participate in Data Security Marks if the attribute should be part of access
control logic.

2. Click the drop-down arrow corresponding to the table in the Entity Name, to view the
attributes in the entity table.

3. Select the attributes for which you want to modify the data from the Attribute Name.

4. Once attributes are selected, click Continue to proceed to Ruleset configuration, where
form logic and validations can be defined.

7.2.2.1.2.1 Creating Data Filters for New Form Definitions

Filters help to view and export specific set of data from data exporter forms.

Complete the following steps if you want to add filters to the Forms Definition:

1. Click on Launch Filter Condition, to access the Filter Condition pane.

2. Enter/ select the following details.

• Column - Select the column from the applying the filter.

• Condition - Select one of the following filter conditions, to filter the column data.

– Comparison - '=', '!=', '< >', '>', '<', >=, <=,'IN', 'NOT IN', 'ANY', 'BETWEEN', 'LIKE',
'IS NULL', and 'IS NOT NULL'.

• Filter Value - Select/enter the filter value.
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Note

For Language Placeholder the default locale language is displayed and
cannot be modified.

3. Click Add to add a new Filter expression. You can add multiple Filter expressions to the
same filter.

The filter is added to the list of filters.

Mouse-over the place holder filter, to view more details about the filter.

4. Click Validate to verify the filter condition is valid.

A confirmation is message is displayed, if the filter is valid.

5. Click Apply, to add the new filter to the filter condition.

6. Click Reset, to clear all the filter expressions and create a new expression.

7. Click Delete to delete an existing filter expression.

8. Click Edit to modify a filter expression. After editing the expression, click Validate, to verify
if the condition is valid. If user wants to update any filter condition, the user can select the
existing condition and then change the condition or filter value and click on Validate to
verify if the condition is valid.

9. Click Apply to add the filter expression to the form definition.

7.2.2.1.3 Ruleset
The Ruleset validates the rules or conditional logic (e.g., mandatory fields, value constraints)
and enables you to apply logic, validations, and formatting rules to the attributes selected in the
form.

1. In the Ruleset tab, you can view the following details.

Table 7-2    Ruleset Table Columns

Field Description

Display Name The label shown on the form for the attribute.

In View Mode Indicates whether the field is visible in read-only/
view mode.

Rules Logic or conditions applied to the field (e.g.,
required, read-only, min/max value).

Format Type Specifies the data type or format (e.g., text,
number, date, dropdown).

2. Select the Attribute listed, and define rules.

3. Click Continue to access the User Security tab or Save to store as draft.

7.2.2.2 Configuring Excel Upload
Excel Upload Definition Type creates new forms based on the uploaded Excel file that has
column names as per the table in the application data source.

While creating forms using Excel Upload, you can also modify the mapping for the attributes.
After the new form is approved from the Forms Definition Summary Page, users with the
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necessary role and permission can perform Data Entry for the records updated by the Excel
file.

Note

Make sure the Excel files are saved in the Microsoft Office 2016 Standard version.
Excel files saved in Office 365 version cause compatibility issues.

To create forms using Excel Upload:

1. Select Excel Upload in the Create Form Definition page and add the following details.

• Code - The unique Form code. This value is auto-generated.

• Name - The Form Name. You can enter between 3 to 100 characters. Only alphabets,
numbers, spaces, and underscores are allowed.

• Description - The Form Definition description. You can enter between 3 to 100
characters. Only alphabets, numbers, spaces, and underscores are allowed.

• Auto Map Entities - Enable this option to auto map the attributes in the Excel file with
the attributes in the Entity Table.

Note

Auto Map attributes feature does not always map all attributes between the
user defined excel and the entities. In such a case where Auto Mapping fails,
the user should manually map such attributes which were not auto mapped.

At any point of time during the form creation, click Save to add the new form to the Form
Summary. The form is saved in the Draft format. Click Actions and select Edit, to update
the form definition.

2. Click Continue to access the File Upload tab.

7.2.2.2.1 File Upload
Upload an Excel file that contains the data you want to ingest into the system. This step
defines the upload template and allows you to add the actual file.

1. In the File Upload tab, enter the following details.

Table 7-3    File Upload

Field Description

Name / Code / Description Displays the template’s predefined name,
system-generated code, and description.

Template Name A user-defined name for the upload template
(e.g., "Q3_2025_Profit_Upload").

Description Optional field to describe the file/template
content.

Drag and Drop Area Upload your Excel file:
Click to browse Or drag-and-drop the file directly

The excel file is uploaded and a confirmation box is displayed, and the Mapped Entities
Tab is displayed.
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2. After the File Upload, click Continue to access the Mapped Entities tab.

7.2.2.2.2 Mapped Entities
This step links the uploaded Excel data to a specific business entity (like a data table or object)
where the records will be stored or processed.

1. In the Mapped Entities tab, select the Primary Entity name of the table that needs to be
modified.

Table 7-4    Mapped Entities

Field Description

Entity Name Use the search bar to find and select the target
entity to map your Excel data to. This is usually a
predefined structure like a database table,
business object, or form entity.

2. Click the search icon or begin typing the entity name.

3. Select the appropriate entity from the dropdown list. Only one entity can be mapped per
upload configuration.

4. Click Continue, to proceed with the Mapped Attributes tab.

7.2.2.2.3 Mapped Attributes
In this step, you map the columns from your uploaded Excel file to the target entity's attributes
(fields). This ensures that data from the Excel file is correctly inserted into the system.

1. Click the grid icon on the left to begin mapping attributes.

A list of entity attributes and corresponding Excel columns will appear.

2. Click the required mapping in the Override Mapping Column and enter the required
attribute name if you want to change the default mapping.

3. Click Continue to proceed to the User Security tab.

7.2.2.2.4 User Security – Map Users / Groups
This section allows administrators to assign access permissions to specific users or user
groups for managing data entry operations. Mapping users with proper authorization ensures
data security and role-based access control.

• Click User Security to select the user or user groups who can perform data entry to
maintain the data in the table.

Table 7-5    User Security

Field Description

Search Bar Used to find users or user groups by name.
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Table 7-5    (Cont.) User Security

Field Description

Mapped Users Displays the list of users or groups currently
associated with the configuration.
It lists available groups such as:

• Application Admin of Data Foundation For
Banking

• Data Maintenance Admin Group
• FRC Data Analyst
• FRC Data Catalog Administrator

Add / Edit Allows administrators to assign or modify users/
groups and define their roles.

Delete Removes selected users/groups from the
configuration.

Authorize Marks the configuration as authorized, which is
often a prerequisite for applying changes.

Duration From / To Defines the validity period during which the user/
group will have access.

Note

Only authorized users/groups can interact with data based on the mapping.
Unmapped users will be restricted.

For more information refer to Approving and Rejecting New Form Definitions. After
approval/auto approval, the form is added to the Form Definition Summary.

7.2.2.2.4.1 Enabling User Security for New Form Definitions

The User Security option helps you to select the users/user groups who can add, edit, delete
and/or authorize forms.

To enable user security:

• Select the required user group or user to assign permissions from the Map Users /
Groups, to complete the user security configuration.

When you select the user group or user, the permissions for each approved Forms
Definition are displayed. These permissions are the actions that the selected user group or
user can perform while performing Data Entry.

Table 7-6    Permissions in the Map Users / Groups Pane

Option Description

Add /Edit Add or modify records in an approved Forms
Definition
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Table 7-6    (Cont.) Permissions in the Map Users / Groups Pane

Option Description

Delete Deletion of all intermediate work (draft / awaiting
records) of a form

1. While closing the action associated to the
form.

2. While picking another form in an action
which already has a form associated to it. All
the intermediate work is deleted / cleaned
up from the previous form before opening
the new form.

Authorize Authorize the records, Return the Action and
Publish action in which the form is present.

Note

A user who submits the form cannot
approve or reject the same form.

Duration From Optional. Select the start date for which the
permissions are available to the user or user
group.

Duration To Optional. Select the end date for which the
permissions are available to the user or user
group.

Note

If you select a user group for User Security, you can view the users mapped to
that group by clicking the Users icon.

7.2.2.2.5 Data Preview
This final step lets users preview the data extracted from the uploaded Excel file before final
submission. It helps verify if data has been correctly mapped, cleaned, and is ready for
upload into the system.

1. Click Data Preview to preview the form data.

2. Click Save if you want to save the forms definition in draft format. The form is added to the
Form Summary with Draft status.

3. Click Submit when Forms Definition is ready for approval. Post approval, the form will be
available in the Data Entry Action in Issues and Actions. For more information refer to 
Approving and Rejecting New Form Definitions. After approval, the form is added to the
Form Definition Summary.

7.2.3 Approving and Rejecting New Form Definitions
You can validate and approve the new Forms Definition if you have the required role assigned
to you.
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If the configuration in the Forms Definition is incorrect, you can reject the Forms Definition. The
rejected Forms Definition changes into Draft status. You can then request the required user to
edit the Forms Definition and submit it for approval again.

You can also view, copy, and edit each Forms Definition from the Forms Definition – Summary
page by clicking Menu. These actions are available based on the roles assigned to you. For
more information, refer Identity Management.

7.2.3.1 Approving a Forms Definition
You can approve new forms based on the assigned roles.

To check about the assigned roles, refer user-roles-and-privileges.

To approve a Forms Definition:

1. In the Designer View, click Menu in the Forms Definition that is in Pending Approval
status, and then click Approve, to access the Configure page.

2. Click Approve and then enter the required description for the approval in the Comments
field.

3. Click Submit, to approve the form definition and view it in the Data Entry page.

Once the form is approved, you can Editing/Amending Form Definitions if you have
DMIDGNAMND role assigned.

7.2.3.2 Rejecting a Forms Definition
You can reject new forms based on the assigned roles.

To check about the assigned roles, refer user-roles-and-privileges .

To reject a Forms Definition:

1. In the Designer View, click Menu in the Forms Definition that is in Pending Approval
status, and then click Reject, to access the Configure page.

2. Click Reject and then enter the required description for the approval in the Comments
field.

3. Click Submit.

The Forms Definition is rejected, moved to draft status. The form definition is displayed in
Forms Definition Summary page. You can then edit the Forms Definition in draft status and
submit it for approval again.

For more information on editing a Forms Definition, see Editing/Amending Form
Definitions.

7.2.4 Managing Form Definitions
You can view, edit, copy, and delete the existing Form Definitions from the Form Definition
Summary Page, based on the assigned roles.

To check about the assigned roles, refer to user-roles-and-privileges.

In the Summary Page, highlight a specific Definition and click Action. The following options
are displayed:
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Table 7-7    Action Details

Action Description

Viewing Form Definitions View the Member details for a specific Member
Definition.

Editing/Amending Form Definitions Edit/amend the Member details of a form
definition.

Copying Form Definitions Copy the Member Definition Details and create
another Member Definition by changing
Alphanumeric Code, Numeric Code and Name.

Re-Uploading Form Definitions Upload a new Excel sheet for an Excel upload form
definition. You need to delete the attached excel
sheet before uploading the new data.

Deleting Form Definitions If you have the required role, you can delete a new
Form that is in Awaiting Approval status.

Approving and Rejecting New Form Definitions If you have the required role, you can reject a new
Form that is in Awaiting Approval status.

7.2.5 Viewing Form Definitions
You can view the form definition details using the View option, based on the assigned roles.

To check about the assigned roles, refer user-roles-and-privileges.

You can view the details of an individual Form Definition:

1. Highlight the Form Definition and click Action.

2. Click View, to access the Form Definition page with the selected Form definition details.

7.2.6 Editing/Amending Form Definitions
You can modify both approved and rejected form definitions, based on the assigned roles.

To check about the assigned roles, refer user-roles-and-privileges. Forms that are already
approved cannot be edited. You can amend the approved forms if you have DMIDGNAMND
role assigned.

Note

You cannot amend an approved form, if the form has any pending data entry activity.

To edit individual form details:

1. Highlight the form definition and click the Action.

2. Click Edit, to access the Form Definition page with the details.

To modify an approved form, click Amend.

3. Update the required information and click Submit.
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Note

Do not edit the Business Key or As of Date attributes. .These are critical for data
integrityand used for identifying unique records.

You can also auto-approve the form during submission.

The modified form definition is updated in the form design summary.

7.2.7 Copying Form Definitions
You can copy individual Definition Details, to recreate another new Definition, if you have
assigned roles.

To check about the assigned roles, refer user-roles-and-privileges.

To copy an existing form definition:

1. Highlight the Definition and click Action.

2. Click Copy, to view the Form Definition Page.

3. Edit the unique information and modify details like entity table, attribute filters, user and
data security details and click Save, to create a new form definition.

7.2.7.1 Re-Uploading Form Definitions
You can attach a new Excel Sheet to an Excel upload form definition and re-upload the form
definition, based on the assigned roles.

To check about the assigned roles, refer to user-roles-and-privileges.

To re-upload an Excel upload form definition:

1. Highlight the Definition and click Action.

2. Click Re-Upload, to access the Form Definition page.

3. In the File Upload tab, click Remove, to delete the existing Excel sheet.

4. Click Drag and Drop and select the new Excel sheet to be uploaded.

7.2.8 Deleting Form Definitions
You can delete the form definitions that are in Draft status, based on the assigned roles.

To check about the assigned roles, refer user-roles-and-privileges.

To delete a form definition:

1. Highlight the form definition and click the Action.

2. click Delete.

The selected form definition is deleted after confirmation.

7.2.9 Data View
The Data View feature of Data Maintenance Interface (DMI) enables you to maintain or modify
the table data by using the Forms Definition that is created and approved from Forms
Definition Summary page.
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If the approved Forms Definition is created by using the designer option, a user with the
necessary role can add or modify the records in the table as per the configuration in the Forms
Definition. These records are then sent to another user with the necessary permission for final
approval.

If the approved Forms Definition is created by using an Excel file, a user with the necessary
permission can verify and approve the records that are modified with the values from the Excel
file. If the records modified by the Excel file are incorrect, the user can reject the records. The
rejected record can be modified by a different user with the necessary role and can be sent for
the final approval again. The Forms Definitions that are created by using an Excel file are
labelled with an Excel icon in Data Entry.

7.2.9.1 Adding Data to Entity – Forms Created Using Data Entry
Once a Data Entry Form is created, the user with the necessary role can add records and also
update the values for the table records as per the configuration in the Forms Definition. Issues
and Actions Governance is followed for adding, approving and Publishing Data using the form.

These records are then submitted for approval to another user with the necessary role. For
more information, refer to user-roles-and-privileges.
To update/delete data in the table records:

1. Highlight the record and click the Action.

2. Click Edit, to update the records. The records are classified based on the following status:

3. Draft – Records that are created but not submitted. In Draft state, you can add new rows
or delete/edit an existing row submitted for auto-approval.

4. Ready – Records that are approved. You can only edit the records.

For adding/deleting records and editing existing draft or Ready records, refer to the
following sections:

Related Topics

• Adding/Editing a Draft Record: You can add a record to the table or edit a record set in
the Draft status. The added record is set to Draft status.

• Deleting Draft Records

7.2.9.2 Adding/Editing a Draft Record
You can add a record to the table or edit a record set in the Draft status. The added record is
set to Draft status.

To add or edit a draft record:

1. Select Draft from the Status drop-down list, to view all the entity records set to Draft
status.

2. To add a new record, click Add.

A new entry set to Draft status is added to Entity details page. This entry is empty. Edit the
record to add the attribute details.

3. To edit a record, click Edit next to the record.

4. In the Edit page, enter the values in the attributes that you want to modify and click OK.

You can repeat the steps for all the records for which the data needs to be entered.

5. To modify all the entries in a specific column, click Bulk Update.

a. Select the column to modify the data.
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b. Enter the new value and click OK.

6. Click the modified record in draft status, and then click Submit.

7. After Publish, the status is changed from Awaiting to Ready. Refer Editing Published
Records, to edit the records in Ready status.

7.2.9.3 Deleting Draft Records
You can delete the records in Draft status. If the record is approved and moved to Ready
status, it cannot be deleted.

1. Select Draft from the Status drop-down list.

The entity records with Draft status are displayed for entering data are displayed.

2. Select a record and click Delete.

7.2.9.4 Editing Published Records
The published records are set to Ready Status.

When you edit the record, it is moved to Draft Status.

1. Select Ready from the Status drop-down list, to view the entity records with Ready status
are displayed.

2. To edit a record, click Edit next to the record.

3. Update the values for the attributes that you want to modify and click OK.

User will have the ability and should not edit the Business Key or ‘As of Date’ attribute of
the entity. You can repeat the steps for all the records for which the data needs to be
entered.

4. To modify all the entries in a specific column, click Bulk Update.

a. Select the column to modify the data.

b. Enter the new value and click OK.

5. Click the modified record in draft status, and then click Submit for Approval.

7.2.9.5 Forms Created Using Excel Upload
When a Forms Definition created using an Excel file is approved from Forms Definition
Summary Page, the table records in the selected table are updated using the data in the Excel
file.

The records are set to Awaiting status for the approved forms definition in data entry page.
You can verify the records modified by the Excel file records and approve them if you are
assigned to the necessary role. If the records modified by the Excel file are incorrect, you can
reject the records. The status of the rejected records is changed to Draft. A user with the
necessary role can edit the records in draft status and submit them for approval again.

• – To approve records, see Approving and Rejecting Records.

– To reject records, see Rejecting a Record.

– To edit a record in draft status, see Editing a Rejected Record .

7.2.9.5.1 Approving and Rejecting Records
A user with the necessary role can approve or reject the edited records.
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For more information related to user roles, refer to user-roles-and-privileges.

7.2.9.5.1.1 Approving Draft Records

You can approve the records set to Draft status.

To approve records:

1. In the Data Entry page, select Draft from the Status drop-down list.

The entity records with Draft status are displayed.

2. Select the required record.

You can select multiple records, to perform bulk Approval. Bulk Approval is enabled only if
Bulk Authorization is activated during Form Creation.

3. Enter the required comment in the Comments Field, and then click Approve.

The record is approved successfully with the values from the Excel file.

7.2.9.5.2 Rejecting a Record
You can reject a record set to Awaiting status.

To reject a record:

1. Click Menu in the required Forms Definition from the Data Entry page.

2. Click Edit.

The Entity Details page is displayed. The records that are waiting for the final approval are
displayed here.

Select the required record, and then click Reject.

You can select multiple records to perform bulk rejection. Bulk rejection is enabled only if
Bulk Authorization is activated during Form Creation.

3. Enter the required comment in the Comments field, and then click Reject.

The record is rejected, and the status is changed to Draft. A user with the necessary role
can now edit the record.

7.2.9.5.3 Editing a Rejected Record
You can edit the records that are in draft status and send them approval to the user with the
necessary role.

To edit a record:

1. Select Draft from the Status drop-down list.

2. Click Edit in the record that you want to edit.

3. Modify the required attributes, and click OK.

4. Select the record and then click Send for Approval.

The modified record is now moved to Awaiting status. A user with the necessary role can
approve the record.
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7.3 Built-in Process Components

7.3.1 Account Load Run Map Population
The Account Load Run Map Population process is a feature in Data Foundation Cloud Service
(DFCS) that manages and organizes the loading of intra-day accounts, particularly for
incremental and snapshot updates.

This section provides an overview of the operation process.

1. Intra-Day Accounts: Accounts are updated within a day based on specific activities or
events, and the system captures these changes efficiently.

2. Incremental and Snapshot Updates:

• Incremental Updates: Only the changes that have occurred since the last update are
captured (e.g., modifications or new records such as transactions or account status
changes).

• Snapshot Updates: A full view of the data at a specific point in time is captured,
including all account data, regardless of whether changes have occurred since the last
snapshot.

3. Load Run ID: Each account load (whether incremental or snapshot) generates a unique
Load Run ID. This ID is used to track, distinguish, audit, and ensure accurate tracing of
each load process.

4. Map Population: The loaded account data is mapped to a predefined structure or schema
within DFCS, ensuring it is correctly placed in the appropriate tables, formats, or structures
for further processing or reporting.

7.3.1.1 Benefits
• Data Traceability: The Load Run ID provides an audit trail for each load operation,

ensuring traceability and transparency.

• Efficient Data Handling: The system can process intra-day account data efficiently by
only loading necessary changes with incremental updates while maintaining full data
integrity with snapshots.

• Consistency: The process ensures that the data is loaded into DFCS consistently and
accurately, making it ready for further downstream applications such as regulatory
reporting, analytics, and other business processes.

In essence, the Account Load Run Map Population process is key in handling dynamic,
intra-day account updates within DFCS, ensuring both data completeness (via snapshots) and
efficiency (via incremental updates).

7.3.2 Configuring Reporting Currency
Pre-requisite:
Before executing Result Area Population jobs, you must configure the necessary settings to
ensure that the Reporting Currency Attributes in the Common Account Derived Attributes
Entity are populated with accurate conversion values. The Currency Exchange Module must
be executed before proceeding with this configuration.

1. Navigate to Administration → Click Run Execution Parameter.
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2. Click Add Run Execution Parameter.

3. Enter the following values in the popup screen:

• Parameter Name – Specify the execution parameter configuration name (required for
executing Result Area Population job).

• Description – Provide a brief description of the execution parameter configuration.

• Currency Rate Type – Select an appropriate value from the Currency Rate Type
Dimension.

• Currency Rate Nature – Select an appropriate value from the Currency Rate Nature
Dimension.

• Currency Rate Version – Choose a value from the Currency Rate Version
Dimension.

• Currency – Specify the target currency for conversion.

4. Click Save.

By completing this setup, the system will accurately derive and populate the Reporting
Currency Attributes for correct financial reporting.

7.3.3 Fact Based Dimension Loader
The "Populating Missing Master Data from Factual Data" feature allows you to extract distinct
values of the specified business term from the factual data which are missing in the Dimension
table and load them into Stage Master tables. This helps to ensure that the references are
accurate in the Fact Results.

This feature allows populating the stage dimension table from Stage Fact tables in case the
source for dimension table did not provide the references.

1. Share the configuration as an excel file with the details such as Dimension Name, Stage
Fact Table Name and Stage Fact Column Name to the support team. SOP will be prepared
based on this and the configuration table will be set. The sample is as follows:

Table 7-8    Configuration

Dimension Name Stage Fact Table Name Stage Fact Column Name

Account Casa Account or Contract Number

Account Credit Derivatives Account or Contract Number

Accounting Standard Commodity Contracts Accounting Standard Code

2. After loading the Stage Fact tables, navigate to the PMF Widget Missing Master Loader
and trigger it. Before triggering the widget, the data between the Stage Master and the
Dimension must be synchronized by running the SCD.

3. For the input As of Date, this feature will extract distinct values of the specified Business
Term (column) from the factual data which are missing in the Dimension table and load
them into the Stage Master tables.

Note

Only As of Date runtime parameter is considered by the Missing Master Loader.
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4. The numeric identifier field for the newly remediated data will be a 14 digit unique number
and for the existing but inactive records of the dimension, it will be the existing numeric
identifier. The Data Source will be set as ‘SYSTEM’.

The non-nullable columns will be set with default values as below:

• Varchar- 'MSG' or Space (If the length of the column is less than 3 characters)

• Numeric- 0

• Flag- 'N'

• Date- As of Date provided by the user

5. Run the SCDs for the remediated Master tables and load the dimensions.

Note

• In case some data is pending to be loaded to Dimension, then the SCD needs
to be executed before the execution of Missing Master Loader.

• Each execution of Missing Master Loader should be followed by an SCD
execution of all the dimensions that are remediated.

• This feature is expected to be used for only remediation of missing records
and must not be primarily used for Stage Master load.

7.3.3.1 Steps to Perform Post Execution Failure
• In case of any failure encountered during the Missing Master Loader execution at a

particular dimension, then none of the records for that dimension will be remediated and
execution will fail and stop.

• Verify the execution logs to verify which dimension remediation has failed.

• Ensure the SCD is executed for all the records for that dimension.

• In case of any failures, the run can be resumed after the required fix so that only the
pending dimensions will be remediated.

Points to Consider

• For customers using EDMCS as single source of dimension data, there will be some gaps
between DFCS and EDMCS.

• Addition of record is limited to the dimension table and no update will be done to hierarchy
tables.

• Dimensions given below cannot be remediated:

– Prime Brokerage Agreement

– Trade Restriction Reason

– Asset Allocation

• Custom Dimensions created with numeric identifier of type SurrogateKey_Long are only
supported for remediation.

• Parallel execution of Missing Master Loader is not allowed.

• During the Missing Master Loader execution, any parallel execution that loads data to the
Stage Master of the dimensions involved in remediation is not allowed.

• Missing Master Loader is not intended to remediate large volume of records.
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7.3.4 Slowly Changing Dimensions
A Slowly Changing Dimension (SCD) is a dimension that stores and manages both current and
historical data over time in a Data Warehouse.

Note

If you have entered the Full Load parameter as YES, you can load snapshot data for
master tables and execute SCD process with additional parameters.
In case, when you have entered the Full Load parameter as YES and if the load is
incremental and does not contain all the nodes, those nodes are retired by default.

When entered as NO, you can load incremental data for master tables and execute
SCD process with additional parameters. The incremental data load for master tables
is supported.
The retired dimensions can be brought back as part of subsequent SCD load by
updating the Closed Flag column to null or N.

Current behavior of Disabled Nodes:

• The Closed Flag attribute is not supported for the Product Processor (PP) accounts.

• A new node in the Stage Master table with Closed Flag Y is supported and will be ignored
during SCD load.

7.3.4.1 Types of SCDs
The type of SCD Catalog supports is:

• Type 2 SCDs - Creating another dimension record: A Type 2 SCD retains the full history of
values. When the value of a chosen attribute changes, the current record is closed. A new
record is created with the changed data values and this new record becomes the current
record. Each record contains the effective time and expiration time to identify the time
period between which the record was active.

The Dimension Data population in the Process Orchestration displays the available SCDs with
details such as Map Reference Number and Entity Name.

7.3.4.1.1 Dimension Data population
Following fields are mandatory and must be sourced.

Table 7-9    Generic Dimension attribute description

Business Term Comments

As Of Date The data must be valid.

Code / Business Key The data must be unique.
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Table 7-9    (Cont.) Generic Dimension attribute description

Business Term Comments

Numeric Identifier Numeric Identifier data should be unique across
business key values, and no two-dimensional
values should share the same numeric identifier.
This can be ensured by generating unique numeric
IDs using the Data Integration component.
Additionally, there are Data Quality (DQ) checks in
place to ensure there are no duplicate numeric
identifiers.

Closed Flag For Example: Y, N, or Null. Null will be considered
as No. This value determines whether the Node is
enabled or disabled.

Name The data must be valid.

Description The data must be valid.

7.3.4.1.2 Hierarchy Data Loading
A Business Hierarchy refers to organizing data into logical tree structure to represent the
groups and relations among various levels at which measure can be viewed. A measure can
be viewed at different levels depending upon the hierarchy breakdown of the dimension
category.

Data Catalog supports data loading using the following Hierarchies:

• Account Hierarchy Dimension

• Cash Flow Type Hierarchy Dimension

• Employee Hierarchy Dimension

• General Ledger Hierarchy Dimension

• Legal Entity Hierarchy Dimension

• Line Of Business Hierarchy Dimension

• Organization Unit Hierarchy Dimension

• Party Hierarchy Dimension

• Product Hierarchy Dimension

• Project Hierarchy Dimension

• Ledger Hierarchy Dimension

• Business Unit Hierarchy Dimension

• Channel Hierarchy Dimension

• Branch Hierarchy Dimension

• Location Hierarchy Dimension

• Instrument Contract Hierarchy Dimension

• Business Segment Hierarchy Dimension
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Note

You must provide the snapshot for the Hierarchy code that has been corrected or
modified when you reload the Hierarchy data.

Hierarchy data loading is a part of the Dimension Data population.

7.3.4.1.2.1 Hierarchy Data Load

Following fields are mandatory and must be sourced.

Table 7-10    Generic Dimension attribute description

Business Term Comments

As Of Date The data must be valid.

Hierarchy Code Each hierarchy code for a specific As Of date must
have one root node.

Effective Date Refers to the effective date of the account or
contract or interest rate or exchange rate from
which it is effective. In the case of hierarchy
dimension entities, it refers to the effective date of
the hierarchy code, and while sourcing data, users
need to provide a snapshot of the latest hierarchy
code with the same effective date. The data must
be valid.

Child Code Child Code should be available in corresponding
Master Table and should be unique.

Parent Code Parent Code should be available in corresponding
Master Table.

Name The data must be valid.

Description The data must be valid.

7.3.4.1.2.2 Account Dimension

Data Platform supports sourcing of account information from Product Processors like Annuity,
Loan contracts, Repo contracts and so on. The Dimension Account must be populated through
Product Processor.

Note

If Product Processor contains data, then Account Dimension must be populated
through Product Processor and you must not populate Account Master.

To populate Account Dimension through Product Processors, perform the following:

1. Execute Account Load Run Map Population pipeline containing the data in Product
Processor tables.

Note

Account Master should not contain any data.
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2. Execute Dimension Population Process pipeline has to be executed for all dimension
table population.

7.3.4.1.3 Use and Execute the Dimension Population Process
Use this Run Pipeline (Process) to manage past and historical data for various Dimensions.

To use and execute the Dimension Population Process in the Process Orchestration, do the
following:

1. To access the Dimension Population Process Pipeline, on the home page, select Data
Pipeline for Process Orchestration. The Process Modeller page is displayed.

2. On the Process Modeller Page, search and select the Dimension Population Process.
The Process Flow Page is displayed. This Process Flow is designed on the Drawing
Canvas using the Transition, Activity, and Widgets Components available in the floating
tool bar. SCD Widgets representing individual SCDs are set up in parallel to each other. At
the end of this process, the Connectors representing Hierarchies are set in parallel.

3. To view the details of any Node, double-click on the Node and the details related to its
Activity, Transition, and Notification are displayed. On the drawing canvas, you can select
and see the Definition, Data Fields, and Application Rule details.

4. To execute the Run, you can select the Run Parameter Values using the Execution Button
on the Process Flow Page or on the Process Modeller Page.

Go to the Process Modeller Page to execute the Run. Click the Menu Button
corresponding to the Dimension Population Process that needs to be executed. Click
Execute Run. The Execution Page is displayed.

5. On the Execution Page, to execute the Run with parameters, select With Parameters in
the Execution Type List. Select the required As of Date for which the SCDs need to be
processed. Select the required Data Source option and click the Apply Button to initiate
the Run Pipeline execution.

Note

The execution of the Run Pipeline is triggered using the selected Extraction Date.
See the Process Orchestration Section for more details about the Process
Orchestration.

6. To verify the Run Execution of the Dimension Population Process, do the following:

a. To open the Process Monitor page, on the Process Modeler page, click the Process
Monitor button or select Process Flow Monitor on the Process Modeler menu.

The Process Monitor page is displayed, which lists all the Run Instances
corresponding to the Dimension Population Process.

b. On the Process Monitor page, search by the Process ID, or by the Process Name
Dimension Population Process, and select the Process Instance for the required
Run Pipeline (Process) that was executed.

7. The Process Flow page is displayed with the Run Execution Status on each Node of the
Dimension Population Process.

8. To verify the Run Execution Logs, do the following:

a. On the Process Monitor page, click the required Process Instance for which you need
to verify the Execution Logs. The Process Flow page is displayed with the Run
Execution Status on each Node.
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b. To see the Execution Status details of a Node, double-click on that Node. The
Execution Status details page is displayed.

c. Click Execution Logs.

The Log Viewer page is displayed, which lists all the Logs related to the Process
Instance.

d. To see the details of a log entry, click the Show More button. Click outside the Log
Viewer page to close it.

Once this pipeline process is complete, ensure to run the Reporting Parent Child
Relation Data Population process to create and refresh parent/child hierarchy data. For
more details, see Create and Refresh Parent/Child Hierarchy Data.

7.3.4.1.3.1 Create and Refresh Parent/Child Hierarchy Data

OBIEE RPD is enhanced to read the data of hierarchies from database. This is achieved using
views in database so that data is pre-prepared before OBIEE layer needs it. Use the Run
pipeline (process) Reporting Parent Child Relation Data Population to create and refresh
parent/child hierarchy data.

Note

This pipeline must be executed even after completing the custom pipeline with SCD
and connector data population.

To use and execute the Reporting Parent-Child Relation Data Population process within
Process Orchestration, follow these steps:

1. On the home page, select the Process Orchestration. The Process Modeller page is
displayed.

2. To execute the run, follow these steps:

a. Navigate to the Process Flow page or the Process Modeller page.

b. Select the Run Parameter Values using the Execution button.

c. On the Process Modeller page, locate the Reporting Parent-Child Relation Data
Population process.

d. Click the Menu button corresponding to the process you want to execute.

e. Click Execute Run. The Execution Page will be displayed.

To execute a run with parameters on the Execution page, follow these steps:

a. In the Execution Type list, select With Parameters.

b. Choose the required As of Date for which the SCDs need to be processed.

c. Select NA as the Data Source option.

d. Click Execute to initiate the Run Pipeline execution.

7.3.5 Results Area Population
Data Foundation has ability to provide data for analytical applications in finance, risk, and
compliance domains. It also has well-designed placeholders to store results data from these
applications.
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Key Features of the Results Area Design

• Design: The Reporting Area data model is a dimensional data model. This means that it
consists primarily of central fact tables (de-normalized), related to multiple dimension
tables, also called a Star Schema. Additionally, the dimension tables are shared across the
star schemas in the reporting mode, meaning they are Conformed Dimensions.

• Support for multiple scenarios of analysis: The reporting data model has been
designed to support scenario analysis of the sort required by financial institutions that need
to measure and report risk and performance under a variety of economic scenarios. The
reporting model provides support for this kind of analysis via a Run Dimension – it allows
analytical engines to load multiple result sets identified by scenarios.

• Support for Cross Functional Reporting: The third critical feature of the Reporting area
design is the support for cross-functional reporting. Majority of emerging needs relate to
the analytical problems at the intersection of the distinct areas of Risk, Performance,
Customer Insight, and Compliance. This is addressed amply by the results area of Data
Foundation.

7.3.5.1 Result Area Entity Data Population Run Execution
The Entity Data Population process involves filling and validating data for entities within the
result area. This ensures accurate mapping, integration, and usability of entity data.

1. Navigate to Data Operations and search for Results Area Entity.

2. On the results window, click on the menu button, and then select Execute Run.

The Execution window appears.

3. In the Execution window, select the Execution Type as Without Parameters.

4. Enter the Object ID. The Object ID is a unique identifier.

5. Enter the RUNPARAM (in JSON format). For example, Run Param:
{"FIC_MIS_DATE":"2024-09-01","RUNPARAM":"TEST"}.

Note

The RUNPARAM value must match the execution parameter configuration
name, ensuring it is identical to the Parameter Name specified in the executing 
Configuring Reporting Currency .

6. Click Execute.

7.3.5.2 Results Area Load Batch
The Results Area Load Batch is a process in Data Foundation Cloud Service (DFCS) that
facilitates the loading of fact results from the staging results area into the final results area
for reporting purposes. This process ensures that the data is properly processed, organized,
and available for consumption by downstream reporting applications.

1. Loading Fact Results:

• Fact results are essentially the processed data that is typically used for reporting,
analytics, and business intelligence purposes.

• These facts could include various financial and transactional data points, such as
accounting entries, general ledger (GL) data, currency exchange rates, and so on.
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• The data in the staging area may be raw, intermediate, or partially processed, and the
Results Area Load Batch is responsible for moving it into the final results area where
it is aggregated, cleansed, and made ready for reporting.

2. Run Surrogate Key:

• The Run Surrogate Key is a unique identifier that allows for tracking and managing
multiple load runs.

• Since data loads may occur multiple times a day, the surrogate key helps to
differentiate between different runs of the same type of fact data (e.g., accounting
entries or GL data). This ensures that even if the data loads are similar, each load can
be identified and handled independently.

• The surrogate key is important for data traceability, ensuring that each batch can be
traced back for auditing, version control, and historical analysis.

3. Examples of Fact Loads:

• Load Fact Accounting Entries: This process loads detailed accounting data, which
includes financial transactions that affect accounts, such as debits, credits, account
balances, and other related financial details.

• Load Fact GL Data: Loads general ledger data, which is aggregated and provides a
summarized view of financial transactions by categories such as account codes,
periods, and balances.

• Load Fact Currency Exchange Rates: Loads data regarding the exchange rates
between different currencies, which are essential for converting financial amounts into
consistent currency representations across different regions.

• Load Fact Accounting Entries Header: This is the header-level data associated with
accounting entries, which may include metadata such as transaction type, reference
numbers, and other summary information.

7.3.5.2.1 Benefits
• Continuous Data Updates: By supporting multiple load runs per day, the system ensures

that the most up-to-date fact data is always available for reporting purposes.

• Efficient Tracking and Management: The use of a Run Surrogate Key.

7.3.6 Average-level Average Balance Computation
Average balance computation is a method used to track and report average and end-of-day
balances for financial institutions. It helps create both average and standard balance sheets
and income statements, which are important for regulatory compliance and internal financial
reporting.

This process is essential for calculating daily and monthly average balances, taking into
account situations like missing data, new accounts, or closed accounts. The following functions
are also supported:

• Period to date (month, quarter and year to date) average values of instrument-level
accounting balance

• Revaluation of instrument-level accounting balance

• Currency translation of instrument-level accounting balance as a part of the period balance
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Table 7-11    Execution Parameters

Parameter Description

MIS Date Business date for which balances are to be
computed. The selection type is a Single Select.

Data Source Source system providing account data. The
selection type is Multi Select.

Product Processor Application that processes the product/account.
The selection type is Multi Select.

Note

For more information on execution of PMF log, see Steps for Execution.

7.3.6.1 Examples of Average Balance Computation
Here are some examples that illustrate the concepts of average balance computation. These
examples show how the application calculates period, monthly average balances.

Monthly Average-to-Date Balances

In this example, the ending balance in an account on July 20th is 100,000 (USD). Here are the
daily activity, end-of-day (EOD), period-to-date (PTD) aggregate, and monthly average
balances for the first three days in August.

Table 7-12    Monthly Average Balances for June

Date Daily Activity End of Day Monthly
Aggregate

Monthly Average
Balance

June 1 5000 105,000 105,000 105,000

June 2 8000 113,000 218,000 109,000

June 3 4000 117,000 335,000 111,667.67

This shows how the Monthly Average balance is calculated by taking the Monthly
Aggregate Balance and dividing it by the Days in Period to Date. In this example, we
calculate the average balance over the first three days of June. Each day’s EOD balance is
added to the Monthly Aggregate, and the Average balance is updated accordingly.

Note

Monthly average balances reset to zero at the beginning of each period.

Effective Date Handling

The effective date of transactions directly affects average balance calculations, as these
balances are based on the transaction's effective date. This date is also crucial when choosing
inquiry or reporting criteria, since reports will show average balances as of the selected
effective date.
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Backdated Transactions and Average Balances

When you post a backdated transaction, the application adjusts the end-of-day and aggregate
balances of the affected accounts, as of the effective date and all subsequent dates.The
following example continues the general example and illustrates what happens when you post
a backdated transaction. Here are the end-of-day and aggregate balances from the example
previously described in the Example of Average Balance computation section.

Day Account A
End-of-Day

Account A
Aggregate

Account B
End-of-Day

Account B
Aggregate

Account C
End-of-Day

Account C
Aggregate

Day 1 1,000 1,000 (1,000) (1,000) 0 0

Day 2 1,100 2,100 (1,000) (2,000) (100) (100)

Day 3 1,100 3,200 (800) (,2,800) (300) (400)

Here's the average balance for each account on Day 3.

Account Calculation Average Balance

Account A 3,200 / 3 1,066.66

Account B (2,800) / 3 (933.33)

Account C (400) / 3 (133.33)

Now assume that the following backdated transaction occurs on Day 3, with an effective date
of Day 1.

Account Debit Credit

Account A 500

Account B 500

The effects of the backdated transaction are shown in the following table.

Day Account A
End-of-Day

Account A
Aggregate

Account B
End-of-Day

Account B
Aggregate

Account C
End-of-Day

Account C
Aggregate

Day 1 1,500 1,500 (1,500) (1,500) 0 0

Day 2 1,600 3,100 (1,500) (3,000) (100) (100)

Day 3 1,600 4,700 (1,300) (4,300) (300) (400)

Here's the average balance now for each account on Day 3.

Account Calculation Average Balance

Account A 4,700 / 3 1,566.66

Account B (4,300) / 3 (1,433.33)

Account C (400) / 3 (133.33)

7.3.6.2 Steps for Execution
1. Navigate to Data Foundation for Banking and click Data Operations. The Process

Modeller Summary page is displayed.

2. In the Search filter placeholder bar, select Pipelines > Run Pipeline > Average
Balance Computation. The available list of Process Id's is displayed.
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3. A dropdown is displayed with the following menu items:

• To access the Process Modeller, click Process Modeller.

• To monitor currently running processes, click Process Monitor.

• To view an overview, click Dashboard.
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8
Data Visualizations

Data Foundation Cloud Service (DFCS) provides users with a powerful Data Visualization
feature to visualize loaded source data and processed results data directly via user interface.
The process of data visualization is very user friendly and does not require any query language
skills like SQL. Custom visualization report can be generated via direct drag and drop feature
on Oracle Analytics and can further be used to analyze data insights effectively. Data
Visualization enables users to explore and visualize data across the following key sections:

• Source Data Visualization

• Results Data Visualization

• Pre-Built reports and KPIs

• Data Quality dashboard

• General Ledger Reconciliation dashboard

• Use Case Analysis

• Right to Forget Executions

• Data Visualization for Custom attributes

8.1 Browsing Data Visualization
Data Visualization UI varies for different set of users. The two types of UI available 2 personas,
Business Analysts and Administrators.

8.1.1 Browsing Experience for Users with Administrator Privileges
1. On the DFCS Home page, navigate to Data Visualization.

Figure 8-1    Data Visualization

User Guide
G39682-03
Copyright © 2024, 2025, Oracle and/or its affiliates.

August 20, 2025
Page 1 of 81



2. This section consists of the following menu options and features.

Table 8-1    DFCS DV Menu Option

DFCS DV Menu Option Path

Source Data Visualisation • Source SA list (expandable to view source
entities within SA)

Figure 8-2    Source Data

• Click to Source entity to View data

Figure 8-3     Source Data Source
Data
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Table 8-1    (Cont.) DFCS DV Menu Option

DFCS DV Menu Option Path

Results Data Visualisation • Results SA list (expandable to view pre-built
reports within SA)

Figure 8-4    Pre-built Reports

• Click to Pre-built report to View the report

Figure 8-5    Pre-built Reports List
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Table 8-1    (Cont.) DFCS DV Menu Option

DFCS DV Menu Option Path

View Pre-built Reports • Results SA list (expandable to view pre-built
reports within SA)

• Click to Pre-built report to View the report

Data Quality Dashboard Data Quality dashboard.

GL Reconciliation Dashboard Balance Reconciliation dashboard

Add New Visualisation • Oracle Analytics Home page
• Create → Workbook → Subject Area or

Dataset (pre-packaged in the product)
• Create → Dataset → Select connection →

Create dataset

8.1.2 Browsing Experience for Users with Business Analyst Privileges
This section describes the Business Analyst privileges.

Figure 8-6    Business Analyst Privileges - DFCS Home page - LoB View
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Figure 8-7    Expandable LoB with list of entities tagged to the LoB

Table 8-2    This table consists of the following menu options and features

DFCS DV Menu Option Click path

Line of Business (LoB) • LoB list (expandable to view source entities
tagged to LoB)

Click to Source entity to View Catalog details for
entities

Figure 8-8    Catalog View of Entities
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Table 8-2    (Cont.) This table consists of the following menu options and features

DFCS DV Menu Option Click path

Browse Data → Source • LoB list (expandable to view source entities
tagged to LoB)
– Select/Expand LoB
– View number of Records loaded

Click View to view Source entity data

Figure 8-9    Browse Data – Source DV
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Table 8-2    (Cont.) This table consists of the following menu options and features

DFCS DV Menu Option Click path

Browse Data -> Results • Results SA list (expandable to view pre-built
reports within SA)

Click to Pre-built report to View the report

Figure 8-10    Browse Data – Results DV

8.1.3 Browsing Experience via Oracle Analytics User Interface
The Data Browser is an interactive tool that allows you to explore and interact with the data
stored in the system. It provides a real-time view of the data entities and their attributes,
making it easier to visualize.

Data Visualization is available via Oracle Analytics via below options:

1. Pre-built reports that are packaged as part of the product

2. Creating Workbook for pre-built Subject areas and datasets

3. Creating a new Dataset, then creating a workbook to view data

To navigate through the Pre-built reports path:

1. Navigate to the Data Foundation for Banking Home page > Data Visualization.

2. Under the Data Visualisation section, click Add new Visualization.

3. From the LHS menu, select Catalog > Shared Folders.

4. From the Shared Folder window, select Data Foundation Reports type. The following
Data Foundation Reports are displayed and each type displays various reports.

• Data Foundation Custom Reports

– Source Data

– Result Data
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– Key Performance Indicators

– Source Data Errors

• Data Foundation Reports

– Source Data

– Key Performance Indicators

– Pre-built Reports

– Reports Glossary

– Right To Forget

– Use Case Analysis

• Data Quality Visualization

– Data Quality

• Reconciliation Framework

– Answers

– Dashboards

– Prompts

– Reconciliation Framework Analytics

– Subject Area Contents

• Data Governance

– Data Quality Monitor

– Reconciliation Differences

8.1.4 Data Foundation Reports

8.1.4.1 Source Data Visualization
Source data visualization enables you to view raw data loaded into staging entities post data
loading. Data visualization is supported for pre-built datasets and is best suited for scenarios
where a query will return a few rows of the output.

Source Data Visualization is intended to provide authorized users tactical access to data that is
moved into DFCS Data Store. Such tactical access is used for verification purposes, primarily
in Test and Non-Production instances.

There are two ways to view source data:

1. Custom source data view

2. Pre-configured source data View

8.1.4.1.1 Custom Source Data View
User can create new visualization reports to view data for specific attributes that are not a part
of pre-configured staging data visualization.

User can create new visualization reports to view data for specific attributes that are not a part
of pre-configured staging data visualization.

1. Create (top right of screen) -> Workbook -> Datasets -> Search for relevant source entity.
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2. Navigate to Create on top right of the screen, select Workbook > Datasets > Search for
relevant entity.

Figure 8-11    Custom source data view

Figure 8-12    Custom source data view 2
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Figure 8-13    Custom source data view 3

Note

Datasetscome as part of out-of-the-box configuration.For any data visualization
requirement other than pre-packaged datasets, user can also create their own Dataset
and report to view the required data.
Refer to Dataset Visualization via Custom Dataset section for more details.

8.1.4.1.2 Pre-configured source data View
User can view subset of staging data that is loaded from the source systems for a selected
pre-configured set of attributes. This is a restricted view that allows users to view only selected
attributes that hold the most commonly referred data. The benefit of having this restricted view
is faster data load and focused visualization of important data only. The solution also
aggregate queries with appropriate filters for use against any dataset.

Data Visualization provided with DFCS can be accessed via following navigation paths:

1. Home -> Catalog -> Shared folders -> Data Foundation reports -> Source Data -> Banking
-> Subject Area -> Individual source entity.

Figure 8-14    Pre-configured source data view
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Figure 8-15    Pre-configured source data view 2

8.1.4.1.3 List of Subject Areas for Source Data Visualisation Reports
The Source Data Visualisation Reports helps admin users to visualize data entities such as
Party, Product, Transaction, and others directly from the source systems or staging layers.

1. From Oracl analytics, Navigate to Shared Folders -> Data Foundation Reports ->
Source Data -> Banking

2. The page displays the subject areas tagged to the stage tables.

• Transaction

• Product

• Product Processor

• Party

• Others

Note

The search bar enables you to filter entities associated with a specific subject
area for example, "Loans." It will display all subject areas related to loans.

3. Click any of the Subject Areas, Eg: Transaction, a list of stage tables is displayed.

4. You will see a list of entities such as:

• Account Transactions

• Forex Transactions

• Casa Transactions

• Cards Payments Transactions

5. Select specific entity for which you want to view data.
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Figure 8-16    Pre-built Source Data Visualization Transaction

Table 8-3    Subject Area components

Column Description

Name Entity name (e.g., CASA Transaction)

Description Displays the brief description

Owner The owner is the POC who updated last.

Modified Timestamp of the most recent data ingestion

6. Click an entity to view the actual record-level data.

7. You can refine your view using:

• As Of Date: Clicked on the As Of Date filter tab to adjust data based on reporting
dates.

Figure 8-17    As Of Date filter

– Select List to allow selection from a predefined list of dates.

– Select Exclude to remove the selected date range from the results.

– Select Null to include rows where As Of Date is null (missing/ undefined).

– Select Date Range to select records that fall within a specific time range.

– Select Relative Time to dynamically filter records based on a relative timeframe
from today (or another reference point).

– Each column represents a field/attribute from the data entity. For the Account
entity, key fields include:
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* Data Source Code – to view data from a specific source system (if multiple
exist).

* Click Create Expression Filter – Opens the expression filter interface to
define advanced logic-based filters.

* Click the three-dots to sort the list of accounts displayed.

* Click Drill to Data Element to enables users to explore related or lower-level
data.

* Right-click to view the interactive data table within the report.

8.1.4.1.4 Exporting Data
Data visualization (source data or results data) can be exported in various format like excel,
csv, PowerPoint and image. You can export the data from the report using multiple methods.

1. Navigate to the Report, on the top-right corner click the Export icon. A pop-up window
appears.

Figure 8-18    Export

Option Description

File Export the current report or canvas view to a downloadable file
(e.g., PDF, Excel, etc.).

Print Send the current canvas/report to a printer.

Slack Share the report directly to a Slack workspace/channel (if
integrated).

Dropdown - Start
on

Lets you choose where the exported view should start from when
accessed via link or QR code.

Default Canvas Exports starting from the default or main canvas of the report.

Selected Canvas Starts the export from the canvas currently selected by the user.

Stage Data Starts the export from a staging or data preparation view (likely
raw or pre-processed data).

QR Code Provides a scannable link to open the report/export on mobile or
desktop quickly.

Copy Link Copies the shareable report/export link to clipboard for quick
sharing.
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2. Click on the three-dots and then select Export.

Figure 8-19    Export

3. Right click on Data -> Export.

Figure 8-20    Export

4. Right click on Data > Edit > Copy Data > Paste to excel. A message Data has been
copied to clipboard is displayed.

8.1.4.2 Results Data Visualization
DFCS supports result entities’ data visualization based on pre-defined out-of-the-box datasets
called subject areas. Each subject area is a pre-configured dataset that brings together all fact
entities of similar grain and includes pre-defined relationships with their related dimension
entities. Customized results data visualization canvases can be created by user to enable
them or other staff to access and analyze results data more as per their specific requirement
for a given subject area. The service offering also includes pre-built pre-built dashboards called
Pre-Built reports for user to view results data.

Results Data visualization represents view of results (fact) data either via tables or via various
graphics forms such as charts, pie graphs, scatter plots and other such sophisticated forms.
Visualization can be for out-of-the box pre-built dashboards or custom requirements of user.
There are many visualizations options that help user display data in the form of tables or
various graphs and charts. Visualizations options include but are not limited to tabular data,
pivots, bar graphs (Vertical, horizontal, stacked bar, etc.) pie charts, line graphs, scatter
graphs, tree map, etc. This makes it easier for user to spot patterns and trends in massive data
sets that are hard to identify with the naked eye. These interactive dashboards can be created
by a business user to enable self and other staff to access information more easily, as data
visualizations created by one user can be shared with other users too. Each graphical element
has the potential to provide granular information that updates all visualizations in the
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dashboard as the user drills down into finer and finer detail even on a single given
visualization.

To summarize, the main goal of results data visualization is to:

• Make results (fact) data available for user for each subject area or granularity.

• Make results (fact) data available for user for tabular view without the need to write
complex SQL queries or without any dependency on any third party application.

• Make results (fact) data available via graphic visualizations for data analysis and MIS
reporting.

• Access out of the box pre-built visualizations and pre-built reports for each subject area.

• Access granular data via drill through.

• Share data visualizations custom created by one user with other users within the
organization.

• Access pre-built Key performance Indicators (KPIs).

• Options to export reports to multiple formats such as Microsoft Excel, Microsoft
PowerPoint, PDF, and so on.

Visualization options can be seen in LHS top under the Visualizations button.

Figure 8-21    Visualization

There are two ways to view results data:

1. Custom results data view

2. Pre-configured pre-built reports

Note

For more information on each subject area, see Pre-Built Reports section.

8.1.4.2.1 Subject Area
A Subject Area (SA) is a pre-configured dataset that includes all fact entities (along with their
attributes) and their associated dimension entities, relevant to a specific functional domain.

Key Features:

• Domain-Specific Data Access – Provides users with a structured view of entities and
attributes needed for a particular functional area.
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• Fact and Dimension Entities – Includes key data points (fact entities) and their contextual
details (dimension entities).

• Supports Multiple Granularities – Most Subject Areas contain entities of the same
granularity, but some may include multiple levels.

Example:

• The Accounts Subject Area allows users to access all account-granularity data,
including dimensions such as product type, party type, and account rating.

• While most entities follow the account grain, some may have different granularities, such
as account-rating or account-address grain.

For optimal data extraction, users should first review the Subject Area Granularity to
ensure they are working with the correct level of detail before extracting data.

8.1.4.2.1.1 List of Subject Areas Supported

The subject areas will be enhanced in future releases to accommodate for more specific
granularities.

Below is the list of subject areas currently supported:

• Accounts

• Transactions

• Financial Ledger

• Party Details

• Risk Mitigants/ Placed Collateral

• Credit Line

• Financial Accounting Entries

Note

Subject Areas come as part of out-of-the-box configuration and can’t be created or
modified by user. For any data visualization requirement other than pre-packaged
subject areas, user can create Dataset and report to view the required data. Refer to
Dataset Visualization via Custom Dataset section for more details.

8.1.4.2.1.1.1 Subject Area Glossary

Each Subject Area has a pre-defined glossary that provides essential documentation for
users, helping them understand data structure and relationships.

• List of all result entities included in the subject area

• Entity granularity of each result entity based on the primary keys

• Attribute name and detailed attribute description for all primary keys

• Entity relationships that define relation of attributes with related dimension entity and the
related attribute

The glossary helps users determine which attributes can be combined in a single visualization
for meaningful insights. A single visualization should include attributes of similar granularities to
avoid Cartesian join issues, which can lead to data misinterpretation.

For Example:
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Attributes from Common Account Summary and Loan Account Summary can be used
together in a single visualization.

• End of Period Balance (EOP Bal) for loans should not be combined across Account
Rating Details and Common Account Summary.

• If an account has three credit ratings from different agencies, it will have three rows
for the same account, repeating the EOP Bal value.

• This could lead to the EOP Bal being aggregated incorrectly (e.g., tripled for a single
account).

Subject Area Glossary can be accessed as below:

• Navigate to the Oracle Analytics page → Catalog → Shared folders → Data Foundation
Reports → Reports Glossay → Subject Area Glossary

Figure 8-22    Subject Area Glossary

8.1.4.2.2 Custom results data view
Users can create new visualization reports to view data for specific attributes of results entities.
Steps to view custom source data in Data View UI are as below.

1. Navigate to the Oracle Analytics home page.

2. On the top right corner click Create → Workbook . The Add Data pop-up screen appears.

Figure 8-23    Custom results data view
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Figure 8-24    Adding New Data

3. From the Select Data drop down, select Subject Area → Choose Subject Area → Add
to Workbook.

Note

Each workbook can have multiple Canvases, similar to the way excel workbook
has multiple sheets.
Each Canvas can have multiple visualizations, similar to the way single excel
sheet can have multiple graphs in single sheet. Maximum of 6 visualization is
recommended in a single canvas for optimum system performance.

User can drag and drop attributes required for analysis from left hand side (LHS)
under data button. This process is very user-friendly and doesn’t require the
abilities of SQL query writing to fetch data.

Add and manage datasets

Inspect and explore data tables

Join multiple datasets together for analysis

Create custom fields or visuals based on the data
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Figure 8-25    Data button

Attributes are displayed in data tab in following order:

• Fact entities in alphabetical order based on Entity logical name

• Dimension entities based on alphabetical order

• Attributes displayed in alphabetical order within fact and dimension entities

• ‘My Calculations’ on left bottom will display any calculation formula added by user

Users can add calculation formula for value measures displayed in the view. Users can
also save and share these custom report created with other users.
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Note

Users can view the following on the canvas.

• Shows datasets as tables (e.g., "Account" and "Address").

• You can drag and drop to create joins between datasets (not yet connected in
the screenshot).

• Right-clicking on a dataset brings up the following options.

– Inspect – Opens a preview of the dataset including data types, column
samples, and row count.

– Open – Opens the dataset in full for editing or creating calculated fields.

– Reload Data – Refreshes the data from the original source.

– Replace Dataset – Swap the dataset with a different one while
maintaining visuals (if compatible).

– Remove from Workbook – Deletes the dataset from the current
workbook.

Figure 8-26    Adding and Replacing a Dataset

• Click Add Dataset (top-right) to include additional data sources.

4. Click on the + icon to add Datasets to selected Subject Area.

5. Select Datasets from the Add Data drop down.

6. Select the required Dataset and click Add to Workbook. For more information, see
Adding Dataset section.

Note

Matching is not allowed as each one has already been matched to a different
Subject Area.

7. Click Save (top-right) to save the workbook.
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Figure 8-27    Saving a Dataset

8.1.4.2.3 Exporting Data
Data visualization (source data or results data) can be exported in various format like excel,
csv, PowerPoint and image.

Steps to export data:

1. Right click on Data -> Edit-> Copy -> Paste to excel.

2. Right click on Data -> Export -> File -> Chose format (PowerPoint, image, pdf or csv).
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Figure 8-28    Data visualization Party Financial Details

Figure 8-29    Data visualization Party Financial Details Export
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Figure 8-30    Data visualization Party Financial Details Export File

8.1.4.3 Data Visualization via Custom Datasets
In the previous sections, the guide covered source data visualization and results data
visualization using out-of-the-box (pre-packaged) datasets and subject areas. This section
includes the steps needed to build a custom dataset for visualization of result data (or stage
and dimension data), for entities that are not packaged in out of the box subject areas or
datasets. Post custom dataset creation, users can use the custom created dataset for data
visualization via workbook creation.

While DFCS contains pre-seeded datasets – which are called results Subject Areas like
Accounts or Transactions, creating your own dataset lets you visualize any entities not
included out of the box. Custom dataset can also be used to visualize data loaded and
processed for custom entities and attributes.

Building a custom dataset allows you to define exactly which fact and dimension entities to
join, how they are joined, and which attributes to include in the view. Once created, this dataset
is ready for visualizing the results data.

Below are the steps to build a custom dataset.

1. Log in to the DFCS application and go to Data Visualization screen (Oracle Analytics).

2. From the home page, in the top-right corner click Create > Dataset and then pick the
appropriate connection.
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Figure 8-31    Custom Dataset

Figure 8-32    Create Dataset

3. On the New Dataset screen, select the appropriate schema. Scroll through the list or use
the search bar to find the tables you need, select, drag and drop them to the right-hand
side join diagram section.

Note

Always drag the fact table in first - positioned at the left - and then bring in each
dimension table you need on top of this fact table, with which you want to create
the join. For example, we can drag in the Fact Common Account Summary table
and the Account Dimension table.

By default, Oracle Analytics will auto-create joins, if you prefer to define them yourself,
toggle Auto Join Tables off.

Figure 8-33    New Dataset
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4. Configure the join between the selected tables. To do this, click the Join icon and configure
the join. Select the type of join you want. Click outside and watch for the join icon to turn
from red to green - green denotes your join is successful.

Figure 8-34    Custom Dataset Visualization

5. With your tables linked, click Edit Definition on each table to select only the columns your
reports require. You can do this by dragging and dropping the required columns.

Figure 8-35    Edit Custom Dataset Visualization
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Figure 8-36    Edit Custom Dataset Visualization_2

6. To ensure consistent data load, change the data access for the table from automatic
caching to “Live”.

7. Save the dataset. To reopen ii, navigate to Oracle analytics, select hamburger menu > data
> datasets > click the three dots in the Actions menu corresponding to the custom dataset,
and select open. Now, navigate to the edit definition window for the table to see section to
configure data access on the right-hand side. Set it to live.

8. Refresh the profile by clicking on the Profile Refresh icon – (next to the Save button on
top). Then press Save

9. Adjust the data types manually, if needed. By default, every column is set to Text. Click the
metadata icon at the top and change numeric measures - like End-of-Period Balance -
from Text to Number. Change Treat As to Measure. This step allows Oracle Analytics to
perform aggregations correctly. Perform this step for all numeric fields as needed.

10. Once required columns have been added and their Datatypes updated, click Save to store
the dataset. This saved Custom Dataset can be used for data viewing and analysis by
clicking Create Workbook in the top-right.
There is also an alternative approach to preparing data using Manual SQL Queries in
the dataset.

After selecting the relevant schema, User can drag the Add Manual Query option onto the
diagram pane, click edit definition, search for the required tables and columns to build
manual query. While writing the query ensure, that you use Logical column name in double
quotes, use schema name before entering table name. Table name is Logical table name
with space replaced with underscore.

Note

Anything inside double quotes is case-sensitive – and you must use the logical
column names correctly.

11. Click Refresh & Preview to validate your results, then save the dataset. Name the
dataset on top left corner and click Save.

To create visualizations using the dataset that has just been created:

From the Oracle Data Visualisation home page:
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1. Click Create -> workbook

2. Select dataset, search for newly created custom dataset -> Add to workbook

3. In the workbook, drag and drop the required columns from the dataset to create the
required visualizations. Change the chart type, based on your analytical need. Do
calculations, if needed.

8.1.4.4 Pre-Built Reports
Most of the subject areas have a corresponding pre-built report for results data visualization.
Pre-Built reports have pre-configured tabular data and data visualization dashboards from the
entities within the subject area. You can view data for the pre-configured set of attributes in
these dashboards. You will have Read-only access to these reports as they are configured out-
of-the-box.

To access these reports, navigate through the following path:

1. Home → Catalog → Shared Folders → Data Foundation Reports.

Figure 8-37    Pre-built Reports

8.1.4.4.1 Credit Line Summary
This pre-built report is based on Credit Line subject area. The dashboard provides a visual
representation of Credit Utilization across different parties and currencies.

• Credit Utilization by Parties: This bar graph illustrates total credit line against the utilized
amount, and helps bank quickly assess the overall credit utilization rate. This helps in
identifying trends over time, such as increases in credit usage which might indicate
economic stress among borrowers or a growing confidence and spending capability. The
visualization helps user analyze credit utilization numbers for each party and currency as
of date and analysis can be done at branch level.

– Objective – To highlight the total credit line and utilized amount for various parties
across different currencies as of given date for selected branch/branches.
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Figure 8-38    Credit Utilization by Parties

• Utilization Across Product Types: The visualization illustrates the total credit line
commitment amounts and the utilized amounts across different products denoted in
multiple currencies. This helps to analyze which products are most and least utilized,
banks can identify successful features or gaps in their offerings. This information can drive
the development of new products or adjustments to existing ones to better meet customer
needs.

– Objective – To highlight the total credit line amount and utilized amount by different
product types for selected branch/branches.

Figure 8-39    Utilization Across Product Types

• Credit Line Distribution: The Visualization provides insight into the predominant credit
line purposes at each branch allows a bank to tailor its products to better match local
demand. This helps management to assess the commitment track to aid in performance
review and Risk management.

– Objective – To view number of credit lines by credit line purpose for each branch
within the legal entity.

Chapter 8
Browsing Data Visualization

User Guide
G39682-03
Copyright © 2024, 2025, Oracle and/or its affiliates.

August 20, 2025
Page 28 of 81



Figure 8-40    Credit Line Distribution

• Credit Line Status: The dashboard illustrates the segregation of credit lines into various
credit status categories such as fully performing, delinquent and impaired. This helps
Banks to quickly identify areas of concern, particularly the proportion of non performing or
delinquent accounts. This allows for early intervention strategies to be deployed, such as
reaching out to customers who are falling behind on payments to offer restructuring or
support services that might prevent further delinquencies.

• Activity - Results Data Browsing

– Objective – To view number of credit lines by credit line status like fully performing,
delinquent, impaired for each branch within the legal entity.

Figure 8-41    Credit Line Status

• Participation and Volume Analysis: The visualizations show the participation flag for
credit lines alongside the sum of total credit line amounts tagged with that flag which helps
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banks in analyzing how participation in specific credit programs impacts their overall credit
portfolio. Participation flag indicates if the credit line facility is a part of the syndication.

– Objective – To highlight the total credit line amounts and Participation counts by Legal
entity and Calendar date.

Figure 8-42    Participation and Volume Analysis

8.1.4.4.2 Accounts Summary
The Accounts dashboard displays two key options available:

• Customer Accounts Summary

• Derivative Summary

8.1.4.4.2.1 Customer Account Summary

This pre-built report is based on Accounts subject area. It provides stakeholders with an overall
summary of credit status of institution's assets such as loans as of the selected date.

Credit Status: This provides a view of end-of-period balance in the reporting currency by
credit status across regions and branches. It enables stakeholders to assess the health of
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credit portfolios and identify areas requiring attention. This helps in monitoring regional and
branch-level credit performance and risk exposure and helps identifying if any specific region
or branch needs attention.

Figure 8-43    Credit Status

Non Performing Assets: Provides a visual representation of non performing assets (NPAs),
where definition of non performing asset is as per jurisdictional regulator and user provides
data marking accounts as NPA. This visualization is based on across regions using bar charts.
It offers insights into the distribution and health of non-performing assets (NPAs) by region.

Figure 8-44    Non Performing Assets

Asset Position Dashboard - This dashboard provides a quick overview of how assets are
diversified by both business type and legal entity, highlighting the differences across the
institution. It can guide strategic focus, resource allocation, and risk assessment. The below
pre-built report displays the following details.
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Figure 8-45    Asset Position Dashboard

1. Asset by Business Type

• Shows how assets are spread across various Lines of Business (LOB).

2. Asset by Legal Entity

• Displays asset allocation by Legal Entities.

Loan Summary - This dashboard displays detailed information about various loan accounts as
of date, including credit limits, loan types, statuses, and balance metrics.

Figure 8-46    Loan Summary

Loan Dashboard - This dashboard visualizes loan data by product for Q1 of the selected year,
focusing on two key financial metrics: The below pre-built report displays the following details.
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Figure 8-47    Loan Dashboard

• 1. End of Period Balance by Product
This chart shows the outstanding loan balances at the end of the quarter for each
product.

• 2. Average Balance by Product
This chart shows the average outstanding balance till date:

Geographical Analysis Dashboard - The dashboard is split into sections based on different
analyses:

Figure 8-48    Geographical Analysis Dashboard

• Regional Analysis: Analyzes the distribution of products or other variables across
different regions.

Chapter 8
Browsing Data Visualization

User Guide
G39682-03
Copyright © 2024, 2025, Oracle and/or its affiliates.

August 20, 2025
Page 33 of 81



• Branch Wise Analysis: Focuses on breaking down data across various branches.

• Other Analysis: It also includes geographical, loan, and asset position analyses.

• At the top of the screen, you can apply filters to narrow down your analysis:

– Calendar Date (Full Range): Allows you to view data over any chosen time frame
(year, quarter, or month).

– Legal Entity Description: Provides options for selecting the legal entities you want to
focus on.

– Region Description: Filter data by different regions.

– Product Name: You can filter data based on product types.

– Hovering over each slice of the pie chart will give you more detailed numerical data
(percentages).

Branchwise NPA - This displays the distribution of non-performing assets (NPAs) across
branches for a particular region, segmented into various credit status categories such as
Bankrupt, Impaired, Written Off, and Delinquent. This chart provides a view of NPA
composition for each branch, enabling stakeholders to quickly assess and compare the extent
and type of financial risk across different branches of a given region. This is especially helpful if
user sees unexpected data for a given region in previous visualization, and wants to view data
spread across branches for that region.

Figure 8-49    Branchwise NPA

Balance Position Dashboard
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Figure 8-50    Balance Sheet Position

1. Balance Sheet Position by Legal Entity:

• This section shows the Common End of Period Balance across various Legal Entities,
broken down by balance sheet category by assets and liabilities.

2. Balance Sheet Position by Business Type:

• This section uses the Line of Business (LOB) breakdown to represent the balance sheet
positions.

• Balance Sheet Category (Asset vs. Liability): Similar to the first chart, you can see the
split between assets and liabilities for each business type.

8.1.4.4.2.2 Accounts – Derivatives Summary

This pre-built report, based on the Accounts subject area, delivers a high-level snapshot of
an institution’s derivative exposure portfolio as of a specific date. It offers valuable insights
into notional values and market positions, , enabling stakeholders to monitor portfolio
positions of different types of derivatives effectively.

Tabular Data (Value by Product and Instrument Type)

This table provides a breakdown of derivative product types (Forwards, Future, Options,
Swaps, Credit Derivatives) and displays their balance by instrument type of underlying product
(Equity, Commodity, Forex, Interest rate, Credit). The values of derivative product type and
underlying instrument type are not hard coded and will be displayed based on actual
derivatives data loaded by the bank.

Table 8-4    Value by Product and Instrument Type

Instrument
Type

Forwards Future Options Swaps Credit
Derivative

Equity 1,944,377 3,119,470 1,223,422 1,682,143 1,765,732

Commodity 1,745,131 2,157,887 1,399,406 1,567,381 411,408

Forex 1,219,397 2,892,709 1,034,113 1,269,609 758,671

Interest Rate 682,596 2,134,086 1,225,732 1,155,755 807,296
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Table 8-4    (Cont.) Value by Product and Instrument Type

Instrument
Type

Forwards Future Options Swaps Credit
Derivative

Credit 918,443 1,223,291 855,056 1,434,478 725,108

Table 8-5    Fair Value by product and Instrument Type

Instrument
Type

Instrument
Type
Description

Forwards Future Options Swaps Credit
Derivative

Equity Positive Fair
Value

1599271.3 966806.5 823363.2 786198.6 416055

Equity Negative
Fair Value

-14873.2 -30692.1 -15208.8 -11493.7 -253309

Commodity Positive Fair
Value

1491224.1 1528794.3 1759512.7 2025793 793067

Commodity Negative
Fair Value

-11835.9 -37570.2 -41187.1 -21249.5 -357225

Forex Positive Fair
Value

623486.6 847360.8 606367.3 824300.4 662408

Forex Negative
Fair Value

-33700.4 -13255.7 -11020.6 0 0

Interest Rate Positive Fair
Value

1126196.5 777706.6 1478005.8 803262.9 346157

Interest Rate Negative
Fair Value

-14886.7 -47041.4 -14092.5 0 -323767

Credit Positive Fair
Value

1276353.1 429605 704020.9 768750.4 315706

Credit Negative
Fair Value

-14886.7 -16610.2 0 0 0

Derivative Performance Tracker

This shows a Derivative Performance Tracker visualized as a bar chart. It compares different
derivative product types based on their notional amounts as of date.

Figure 8-51    Derivative Performance Tracker
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Derivative Performance Tracker by Instrument Type

Purpose: Tracks overall derivative portfolio in graphical format based on Instrument type of
underlying exposure.

Figure 8-52    Derivative Performance Tracker by Instrument Type

Derivative Allocation Overview

Purpose: Displays portfolio distribution by various derivative types in the form of a pie chart.

Figure 8-53    Derivative Allocation Overview

Insights Provided:

• Visual assessment of asset allocation

• Highlights concentration risks

• Supports diversification efforts
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OTC vs. Exchange-Traded Derivatives Breakdown

Purpose: Compares notional exposure between OTC and exchange-traded contracts.

Figure 8-54    OTC vs Exchange Traded Derivatives Breakdown

Insights Provided:

• Highlights potential credit and counterparty risks associated with OTC Derivatives

• Aids in assessing risk mitigation needs

Instrument Type Distribution

Purpose: Helps visualize proportion of each category of derivative based on underlying
instrument type within the whole portfolio.

Figure 8-55    Instrument Type Distribution

Chapter 8
Browsing Data Visualization

User Guide
G39682-03
Copyright © 2024, 2025, Oracle and/or its affiliates.

August 20, 2025
Page 38 of 81



Insights Provided:

• Detects over-concentration and potential risk hotspots

• Enables proactive rebalancing and enhanced risk control

8.1.4.4.3 General Ledger Analysis
Financial General Ledger pre-built report is based on subject area by the same name. It
provides stakeholders with an overall summary of institutions’ Chart of Accounts (CoA) as of
the selected date.

General Ledger Analysis and GL Account Distribution

The first two dashboards feature a series of donut visualizations that display the 5 main CoA
categories of Assets, Expenses, Liabilities, Owner’s Equity, and Revenue. Each CoA
category has separate donut view for every currency where bank has exposure. The donut
shows breakdown for the CoA by the types of General Ledger (GL) data for each currency.

For example: For CoA of Assets, banks may have data spread across various currencies.
Donut will show view for Assets spread across their natural currencies by various GL types
(means asset types here) like Cash, Inventory, Fixed Assets, and so on.

The graph displays a General Ledger (GL) Account Distribution Overview in a visual
format, with data organized by different currencies and financial categories. Each row
corresponds to a specific currency, and within each column, the financial distribution is shown
across key categories: Asset, Expense, Liability, Owners Equity, and Revenue.

First dashboard shows the data in local currency, whereas second dashboard shows data in
common accounting currency. Third dashboard shows data spread across various GL
Accounts for Budgeted Vs Actual Vs Forecasted numbers.

Figure 8-56    General ledger Analysis

GL Account Distribution
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Figure 8-57    GL Account Distribution

Actual vs Budget vs Forecast

The Actual vs. Budget vs. Forecast visualization provides a view of budgeted GL numbers and
their comparison with actual numbers and forecasted numbers for future periods.

By visually depicting these differences, it enables banks to analyze the accuracy of their
budgeting and pinpoint areas of over- or under-budget spending, assess alignment with
financial goals, and refine future budgets to enhance accuracy and effectiveness in financial
planning. Forecasted numbers can give a view into future projections vs current numbers.

Figure 8-58    Actual vs Budget vs Forecast

8.1.4.4.4 Mitigants Summary
This pre-built report, based on the Mitigants subject area, offers a comprehensive view of
risk reduction strategies implemented across products, branches, and regions. It aids in
evaluating the effectiveness of various mitigants, identifying exposure gaps, and enhancing
risk management practices.
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Mitigant Summary

A mitigant summary table displays various mitigating factors or actions designed to reduce risk
or exposure. In financial contexts, this could refer to strategies or assets that reduce the risk
associated with liabilities, investments, or other financial obligations.

Figure 8-59    Mitigant Summary

Mitigant and Risk Coverage

Purpose: Tracks the usage and value of different risk mitigants over time.

Figure 8-60    Types of Mitigants Received

Product Wise Risk Coverage Where Mitigants Are Accepted

Purpose: Provides the exposure amounts for various financial product types, segmented by
whether risk mitigants (collateral or guarantees) are accepted.
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Figure 8-61    Product Wise Risk Coverage Where Mitigants Are Accepted

Note

Users have an option to filter for Uncovered as Mitigant type, as some banks capture
Uncovered portion of exposure (with Mitigant type as Uncovered) in separate row in
Entity Fact Account Mitigant Map.

Specific Product Risk Coverage – Trend Analysis

Purpose: Tracks historical trends in risk coverage across individual product types.

Figure 8-62    Specific Product Risk Coverage – Trend Analysis

Insights Provided:

• Visibility into changes in product-level exposure

• Evaluation of mitigant impact over time

• Strategic input for improving product-specific risk handling

Covered Amount vs. End Of Period Balance by Branch

Purpose: Shows covered and end of period balance values across branches as of a given
date.
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Figure 8-63    Covered Amount vs. End Of Period Balance by Branch

Insights Provided:

• Branch-level exposure visibility

• Effectiveness of mitigants at individual locations

• Identification of high-risk branches for further action

Product-wise Risk Coverage Across Branches

Purpose: Combines product and branch views to assess risk coverage at a granular level.

Figure 8-64    Product-wise Risk Coverage Across Branches

Insights Provided:

• Detailed branch-level performance by product type

• Coverage adequacy and gaps

• Data to support localized mitigation strategies

Regional Product Distribution Dashboard

Purpose: Offers a snapshot of how products are distributed across regions.
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Figure 8-65    Regional Product Distribution Dashboard

Insights Provided:

• Product demand by geography

• Regional risk profiles

• Market segmentation and strategic planning inputs

8.1.4.4.5 Party Summary
This pre-built report is based on party subject area. It provides stakeholders with an overall
summary of parties to which bank has exposure. It gives view into parties and their related
parties, along with the financial exposure numbers like total assets vs liabilities outstanding
against all parties. It also gives view into parties’ risk profile analysis based on their credit
rating.

• Risk Profile Analysis: This visualization illustrates the risk profile of parties to which the
bank has credit exposure, based on their credit ratings as of the selected date. The bar
chart displays credit ratings along with the corresponding number of parties for each rating.
Users can filter the data based on Domestic vs. Foreign ratings and Rating Source
Code (Rating Agency) using the filter options provided at the top of the visualization.
Each rating source code is shown alongside the count of party identifiers, offering a clear
view of the risk rating distribution.

This visualization helps assess the overall risk landscape of institutional assets, such as
loans, enabling informed decision-making and effective risk management strategies.

The dashboard includes several default filters, such as Calendar Date, Purpose
Description for Domestic/Foreign Currency Ratings, and Rating Source Description,
allowing users to tailor their view based on specific preferences or requirements.

– Objective: To highlight the number of parties for each credit rating by a specific Credit
Agency and rating purpose.
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Figure 8-66    Risk Profile Analysis

• Party Financial Details: The visualization displays the total assets and liabilities of the
parties for the financial period as per selected Calendar date. Each party is listed with its
corresponding asset and liability amount, highlighting their financial position/obligation for
the selected calendar date. This analysis provides insights into the key contributors to the
organization's asset/liability base, aiding in performance assessment. This analysis also
facilitates insights into risk assessment and financial planning. User also has the option to
select specific party name from filter attribute on top and get view for a specific party.

– Objective – To highlight total amount of asset and liabilities against all parties or
specific party as of specific date

Figure 8-67    Party Financial Details

– Party Party Relationships and Party Party Account Relationship: Party relationship
visualizations provides a view of party relationships and their associated accounts
details. Relationship between related party and primary party could be personal like
spouse, parent, etc. of primary account holder or professional like CEO, Director of an
organization that is bank’s customer.

• Party Party Relationships:

– Objective – To highlight the relationship between different parties and relationship
effective date.
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Figure 8-68    Party Party Relationships

• Party Party Account Relationship:

– Objective – The dashboard gives view of party relationships and their associated
accounts.

Figure 8-69    Party Party Account Relationship

8.1.4.4.6 Placed Collateral Summary
This pre-built report, based on the Placed Collateral subject area, provides a
comprehensive overview of collateral posted against exposures. It includes details about the
type, value, and distribution of collateral placed across different products and regions,
enabling effective monitoring of placed collaterals from within bank’s asset portfolio.

Note

This report is about collaterals placed by the bank, and not collaterals received.
“Mitgants Summary” pre-built report caters to received collaterals.

Types of Collateral Placed

Purpose: Shows the market value of different collateral types placed to secure liabilities,
segmented by year.
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Figure 8-70    Types of Collateral Placed

• The distribution and scale of collateral types placed to mitigate borrowings.

Product against which collateral placed

Purpose: Assesses the portfolio of various product types against which collateral has been
placed.

Figure 8-71    Product against which collateral placed

Branchwise comparison of Collateral Market Value

Purpose: Analyzes how placed collateral is distributed across different branches.
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Figure 8-72    Branchwise comparison of Collateral Market Value

Branch Product Coverage Dashboard

Purpose: Displays product-wise placed collateral coverage at the branch level.

Figure 8-73    Branch Product Coverage Dashboard

Branch-wise EOP Balance vs. Collateral Market Value

Purpose: Compares End-of-Period (EOP) balances across branches to placed collateral
market values at each branch.
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Figure 8-74    Branch-wise EOP Balance vs. Collateral Market Value

8.1.4.4.7 Transaction Summary
These pre-built interactive reports, based on the Transactions subject area, provide detailed
insights into bank inflows and outflows. The reports support informed decision-making across
liquidity management, customer behavior analysis, and operational strategy.

Top 10 Transactions

Purpose: Offers a quick snapshot of the top highest-value inflow or outflow transactions during
a selected period.

Figure 8-75    Top 10 Inflow – Outflow Transactions

• Features:

– Interactive filters for selecting inflows or outflows.

– Useful for tracking major deposit sources or significant fund disbursements.

• Insights Provided:

– Liquidity trends

– High-value transaction impact
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– Customer behavior

Top 10 Parties for each Transaction Type

Purpose: Shows the top 10 parties based on transaction volumes for each transaction type.

Figure 8-76    Parties by Transaction Type

• Features:

– Tabular visualization

– Segregated by transaction category

• Insights Provided:

– Identification of key customers or business partners

– Behavioral patterns by transaction type

Transactions Above Chosen Threshold

Purpose: Focuses on transactions exceeding a user-defined monetary threshold.
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Figure 8-77    Transactions Above Chosen Threshold

• Features:

– Dynamic filters and sorting options

– Supports filtering by inflow or outflow

• Insights Provided:

– Identification of high-value activities

– Risk and liquidity monitoring

– Strategic cash management

Transaction Analysis

Purpose: Displays geographic transaction trends.

Figure 8-78    Total Inflow- Outflow Transactions of Legal Entity by Region and Branch

• Features:

– Regional and branch-level breakdown

• Insights Provided:

– Hotspots of activity
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– Fraud detection opportunities

– Regional growth and service optimization

Regional Analysis by Transaction Type

Purpose: Displays how transaction types are distributed across different regions.

Figure 8-79    Regional Analysis by Transaction Type

• Features:

– Stacked bar charts

• Insights Provided:

– Popular transaction types by geography

– Regional customer preferences

Branch-Wise Analysis of Specific Region

Purpose: Compares branch performance within a selected region.

Figure 8-80    Branch-Wise Analysis of Specific Region

• Features:
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– Transaction volume visualization per branch

• Insights Provided

– Performance benchmarking

– Localized strategic planning

Transaction Type Distribution

Purpose: Offers a complete view of how funds move across different transaction types.

Figure 8-81    Transaction Type Distribution

• Features:

– Color-coded for inflow vs. outflow

• Insights Provided:

– Most frequent transaction activities

– Balanced view of cash flow behavior

Geographic Analysis - Regional Inflow Analysis

Purpose: Shows percentage contribution of each region to total inflows.

Figure 8-82    Regional Inflow Analysis

• Features:

– Filters for specific transaction types

• Insights Provided:
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– Regional deposit trends

– Customer deposit behavior

Regional Outflow Analysis

Purpose: Displays regional contributions to total outflows.

• Features:

– Filters by transaction types

• Insights Provided:

– Regional spending trends

– Liquidity risk identification

Branch-Wise Inflow Analysis

Purpose: Breaks down inflow activity at the branch level.

Figure 8-83    Regional Inflow Analysis

• Features:

– Filter by transaction types

• Insights Provided:

– Top deposit-generating branches

– Targeted deposit strategies

Branch-Wise Outflow Analysis

Purpose: Details outflow trends across branches.

• Features:

– Filter by transaction types

• Insights Provided:

– Lending/spending behavior

– Branch-level financial insights

8.1.4.4.8 Financial Accounting Entries Summary
The Financial Accounting Entries Summary dashboard provides a comprehensive view of
transactions across different currencies, branches, assets, liabilities, and event types. It is
designed to support financial analysts and business users in monitoring and comparing credit
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and debit values across multiple dimensions for a given transaction period. Users can choose
appropriate filters for Transaction Year, Quarter or Month.

• 1. Amount of Credit in Account Currency: This bar chart visualizes the total credit
amount (in account currency) per currency type.

Figure 8-84    Amount of Credit in Account Currency

• 2. Branchwise Comparison of Debit and Credit: This matrix chart compares debit vs.
credit values across branches for each currency.

Figure 8-85    Branchwise Comparison of Debit and Credit

• 3. Total Credit Amount for Assets: This donut chart breaks down the total credit
amount for assets by general ledger account names.
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Figure 8-86    Total Credit Amount for Assets

• 4. Total Credit Amount for Liabilities: This donut chart presents total credit amounts
for liabilities categorized by general ledger accounts.

Figure 8-87    Total Credit Amount for Liabilities

• 5. Event Type Distribution of Total Credit Amount: This bar chart displays the total
credit amount per event type, grouped by currency.
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Figure 8-88    Event Type Distribution of Total Credit Amount

8.1.4.4.9 Drill through option
Drill-down functionality enables user to view data at the lowest granularity. The lowest
granularity level at which the user is able to drill is specific to a given subject area (SA) on
which visualization is based and attributes present in that subject area. For example: In
Account subject area, the lowest level granularity would be accounts (account key in fact
entities and account identifier in stage entities). Similarly for transaction subject area, lowest
level granularity available for viewing via drill through will be transaction identifier.

The solution currently supports drill-through up to data in results entities, and not for stage
entities.

Functionality is available for all pre-built reports for attributes that are contributing towards data
for that pre-built report. Drill through can be done for all types of visualizations including but not
limited to tabular, pivots, graphical, pie charts, time series, and so on.

Data viewed post drill-through pre-applies all the filters and shows user the specific granular
data that user was viewing before drill through.

1. Go to chart where user needs to see specific data -> Right click -> Drill to attribute/
Hierarchy -> Select specific hierarchy for which user wants to view data.
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Figure 8-89    Drill through option
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Figure 8-90    Drill through option Data Elements

8.1.4.5 Pre-built Key Performance Indicators (KPIs)
Key Performance Indicators (KPIs) are pre-calculated values in the solution that measure
performance for a specific objective over time. KPIs provide measurable metrics for
businesses to track over time and gauge their progress. They also help with insights that help
FI business leaders to make data driven decisions, measure their performance and plan at a
strategic level.
Some pre-built KPIs are packaged in out-of-the box product and can’t be modified by the user.
However, user has the flexibility to create their own KPIs.

The solution aims to cover most indicators used across the banking and FI industry.

Currently, the solution supports Account based KPIs for Loans and Deposits.

To access these visualizations, navigate through the following path:

1. Home → Catalog → Shared Folders → Data Foundation Custom Reports→ Key
Performance Indicators.

2. The below results are displayed.

• Balance Sheet

• KPI Source Data
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The dashboard has a default set of filters as shown below and further filters can be added
by the user.

Figure 8-91    Pre-built Key Performance Indicators (KPIs)

3. Click on Balance Sheet. The below report is displayed.

Figure 8-92    Balance Sheet - Casa Ratio

Figure 8-93    Coverage Ratio

4. Click on KPI Source Data. The list of reports summary is displayed.

• Common Account Summary

• Source Data - Cards

• Source Data - Loan Contracts

• Source Data - OD Accounts

8.1.4.5.1 Pre-built Loans and Deposits KPIs
KPIs related to Loans and Deposits KPIs are included as part of out of the box product. Users
can create their own KPIs and visualizations for that for their custom requirements.
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Note

This user guide does not explain individual visualization chart details, their calculation
logic and their interpretation as that is included as part of KPI glossary.

8.1.4.5.1.1 End of Period

This report presents a comparative analysis of Total Loans and Total Deposits as of specific
date, allowing users to examine the balance sheet dynamics and assess the relationship
between lending activities and deposit mobilization. Please refer to KPI Glossary in solution for
further details.

Users have options to choose values for pre-configured filter attributes or add their own filters.

Figure 8-94    End of Period

8.1.4.5.1.2 Time Series

This report gives a view into trend analysis of total outstanding loans, deposits and
investments over multiple time periods and how they have changed over time. It gives
breakdown of deposit types accepted and loan types floated in the market. It also shows
snapshot of Debt and Equity Investments over multiple time periods. Users have options to
choose values for pre-configured filter attributes or add their own filters.
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Figure 8-95    Time Series

8.1.4.5.1.3 Deposit Growth

The Deposit Growth Visualization provides an insightful analysis of a financial institution's
deposit portfolio, focusing on key deposit categories of Current or check-in Account and
Savings Accounts and their movement over time periods. By offering detailed insights into
CASA ratio, total deposits, CASA deposits, and term deposits, users can effectively track and
analyze growth trends across different deposit categories.

Figure 8-96    Deposit Growth

8.1.4.5.1.4 Loans Growth

The Loans Growth Report offers a detailed analysis of loan, credit cards and overdraft
performance, highlighting both the total outstanding amounts and growth percentages for each
category. It enables users to evaluate lending trends across segments such as personal,
business, and auto loans, as well as credit card usage in retail and business domains.
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The charts display the total outstanding loan balances across all types of loans and their
corresponding growth percentages. It provides an overall view of the organization's lending
portfolio and its growth trends over time.

Figure 8-97    Loans Growth Report

8.1.4.5.1.5 Drill through for KPIs

Drill-down functionality enables user to view KPI data at the lowest granularity.

User starts pre-built report visualization from results (fact entities based) -> drill down to
more granular results (multiple levels of drill down in fact entities) -> View data at lowest
granularity.

Example:

Time Series report -> Education Loans KPI -> Country name drill down -> Party type (or party
name) drill down -> Account skey in fact common account summary -> Stage Loan Contracts

Figure 8-98    Drill through for KPIs

Hover over education loans as shown below to look at overall numbers:
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Figure 8-99    Balance Sheet KPIs

Right click and select Country name from drill down option as below:

Figure 8-100    Drill
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Figure 8-101    Drilldown at Country

Figure 8-102    Drill down to Party Name

Figure 8-103    Party Name Drill down
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Figure 8-104    Drill down for account level

Figure 8-105    Account drilldown

8.1.4.6 Data Quality Visualizations
The Data Quality Visualization provides critical insights into data quality issues detected after
executing Data Quality (DQ) rules within the DFCS solution. The DFCS solution runs
predefined DQ rules and publishes the results in interactive dashboards. The dashboards
present a comprehensive view of error records associated with specific entities, helping users
identify data inconsistencies.

To access DQ dashboards, follow the below path:

Data Quality Dashboard > Catalog > Shared folders > Data Quality Visualizations > Data
Quality.

This section provides information on the Data Quality results for Data Visualization reports.
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To access the Data Quality for Data Visualization Reports in DFCS, complete the following
steps:

• On the Home page, click Catalog, and under the Shared Folders tab, select Data Quality
Visualization and then select data Quality Reports to view the details of the Data Quality
results.

• Data Quality Results for Data Visualization Reports page
You can navigate among the following canvases in the Data Visualization report:

– Data Quality Registry

– Data Quality Summary

– Data Quality Executions

– Data Quality Results

Figure 8-106    Data Quality Registry

Controls and Filters

– Hover over any entity in the word cloud to view a tooltip showing:

* Number of Checks

* Entity Name

– Number of Checks – Filter data by the number of checks.

– Class – Apply filters based on data class (e.g., contracts, accounts).

– Type – Filter checks by type (e.g., financial instruments).

– Severity – Filter by severity level of issues.

– Click the three dots (menu icon) in the top-right corner of the chart area.

– Hover over Sort By to reveal options:

* Number of Checks →

* Low to High

* High to Low
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* None

* Entity → Sort alphabetically

– From the same menu (three dots), hover over Edit.

– Click Copy Data to copy the dataset underlying the visualization for external use (e.g.,
Excel, analysis tools).
From the menu, go to Export, then select your preferred method:

* File – Download the chart/data as a file (likely CSV or image).

* Print – Send the visualization directly to a printer.

* Slack – Share directly to Slack (if integrated).

– Drill to Attribute / Hierarchy

1. Select Drill to Attribute/Hierarchy.

2. In the pop-up panel, choose from available Attributes or Hierarchies.

Drillable Attributes Include:

* Date – View checks across time.

* Data Quality Check – Get detailed check names.

* Data Quality Check Severity – Break down checks by severity (e.g., High,
Medium, Low).

* Data Quality Check Type – See types of checks (e.g., Consistency,
Completeness).

* Data Quality Group – Group-level analysis.

* Data Quality Entity – Deeper entity-specific view.

Note

Use the Search bar to quickly locate specific attributes.

* Filter Values: Choose specific values to include.

* Clear All Filter Selections: Unchecks all selected filters.

* Remove All Filters: Resets the dashboard to its unfiltered state.

* Create Expression Filter: Create custom logic filters using expressions.

* Auto-Apply Filters: Toggle whether filters apply changes instantly or only after
confirming.

* Reset Column Sizes: Restores column widths to default in table views.
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Figure 8-107    Data Quality Summary

Figure 8-108    Data Quality Execution
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Figure 8-109    Data Quality Results

8.1.4.7 Balance Reconciliation Visualizations
The GL Reconciliation process ensures that balances from a bank's operational systems
(typically standard product processor entities) are reconciled with the General Ledger (GL)
balances.

GL Reconciliation Visualizations: The dashboards provide insights into reconciliation
differences detected after executing the reconciliation process. Key components include:

• Reconciliation Dashboard

– Reconciliation Execution Summary – Displays the execution summary of the
specified criteria.

– Reconciliation Differences – Highlights discrepancies between operational balances
and GL balances.

– Adjustments Summary – Displays adjustments made to correct discrepancies.

• Threshold Breach

– Threshold Breach Summary – Identifies instances where reconciliation variances
exceed predefined thresholds.

– Global Threshold Breach Summary - The Global Threshold Breach Summary
provides a consolidated view of data quality issues where checks have exceeded pre-
defined acceptable limits (thresholds).

– Threshold Definition Summary - The Threshold Definition Summary outlines the
rules and acceptable limits set for data quality checks. These thresholds determine
whether a particular check passes or fails, based on predefined business or
regulatory standards.

• Map Filter Report

– Reconciliation Source Filters help users narrow down data quality checks to specific
source systems involved in reconciliation.

– Reconciliation Target Filters allow users to refine data quality results based on the
target system or dataset involved in reconciliation. These filters help identify where
mismatches or data quality issues occur on the receiving side of a reconciliation
process.

Chapter 8
Browsing Data Visualization

User Guide
G39682-03
Copyright © 2024, 2025, Oracle and/or its affiliates.

August 20, 2025
Page 70 of 81



– Reconciliation Dimensions define the key attributes used to match and compare
data between source and target systems. These dimensions determine how records
are grouped, aligned, and validated during reconciliation processes.

Steps to Access GL Reconciliation in DFCS:

1. On the Home page, navigate to the Data Visualization > GL Reconciliation Dashboard.
The Reconciliation Framework Analytics screen is displayed.

2. Click on Dashboards to view GL reconciliation results.

Accessing GL Reconciliation Dashboards

To view the GL Reconciliation Dashboards, follow these steps:

1. Navigate to Shared Folders.

2. Select Reconciliation Framework.

3. Click on Dashboards to access the reconciliation results.

GL Reconciliation Results – Data Visualization Reports:

Within the Data Visualization Reports, users can navigate through the following canvases:

• Home – Overview of reconciliation results.

• Threshold Breach – Displays instances where reconciliation variances exceed predefined
limits.

• Map Filter Report – Provides a detailed view of reconciliation mappings and applied
filters.

Figure 8-110    Access GL Reconciliation in DFCS

For further details on using dashboards, refer to the Oracle® Financial Services Data
Foundation Cloud Service for Banking Data Controls User Guide.

8.1.4.8 Use Case Analysis
The Use Case Analysis is a pre-built, out-of-the-box report designed to support customers
who choose to onboard multiple applications in a sequence. In this context, each application
represents a distinct use case. The report provides customers with a clear view of how many
additional data elements would be required to onboard subsequent applications after starting
with one. It also highlights the total number of data attributes used by each application, the
number of common attributes shared across applications, and the additional attributes unique
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to each application. This helps customers plan and manage their data onboarding process
more efficiently.
To access DQ dashboards:

1. Navigate to the Catalog menu from the Oracle Analytics home page, and click on the
Shared Folders tab.

2. Navigate to Data Foundation Reports.

3. Locate the Use Case Analysis folder in the list and click Use Case Analysis.

4. Inside the folder, open the Use Case Analysis report.

The Use Case Analysis > Visualize window appears.

Figure 8-111    Visualize Window

Use Case Analysis Window
Here’s a breakdown of the main items available in the Use Case Analysis window. On the
Visualize window, the following canvas are available in the Use Case Analysis report:

• Summary – Overview of all use cases and attributes.

• Use Case Details – In-depth details for each use case.

• Use Case Comparison – Side-by-side comparison of use cases.

• Attribute Details – Breakdown of attributes within each use case.

Summary
The Summary section provides an overview of how to use the tool effectively, including how to
assess additional elements required for integration with other financial products.
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Figure 8-112    Summary Window

• Determine the impact of additional financial products.

• Identify missing elements needed for full integration.

• Understand table relationships between different applications.

• Percentage-Wise Requirement AnalysisIdentifies percentage gaps (e.g., a customer needs
to bring in the remaining 25%).

• Helps determine which additional datasets, calculations, or reports are necessary for
complete functionality.

• Balance Sheet & Customer Data IntegrationEvaluates which balance sheet elements must
be incorporated.

• Assesses customer data integration requirements for analytics and compliance.

Use Case Details
The Use Case Details section provides an overview on how to analyze entity usage across
various use cases in financial or business management.
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Figure 8-113    Use Case Details

• Check the percentage indicator to see what portion of the required data is already
available.

• Review the missing components and determine what additional elements must be
integrated.

Use Case Comparison
This section provides an overview on how to compare attributes across different financial/
business use cases. It displays percentage coverage of attributes between the reference use
case and comparative use case.

Figure 8-114    Use Case Comparison
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• Reference Use Case: Acts as a benchmark for evaluating other use cases.

• Comparative Use Case: The use case that is directly compared to the Reference Use
Case.

• Number of Common Attributes: The count of shared Entity.Attributes between the
Reference and Comparative Use Cases.

• Number of Additional Attributes Required: The count of extra Entity.Attributes needed
for the Comparative Use Case that are not included in the Reference Use Case.

• % of Comparative Use Case Attributes Available in Reference: The percentage of
attributes from the Comparative Use Case that are present in the Reference Use Case.

Example

The pop-up tooltip (hovered over any entity) provides:

• Number of attributes in the Reference Use Case (1,210).

• Number of attributes in the Comparative Use Case (1,881).

• Number of Common Attributes (194).

• Number of Additional Attributes Required (1,687).

• Percentage of Comparative Use Case Attributes available in the Reference Use Case
(10%).

• Insights:

– High percentages (green areas) indicate a strong overlap of attributes between
reference and comparative use cases.

– Low percentages (red areas) suggest gaps or differences between the datasets.

– Some cells show 100% coverage (e.g., "Funds Transfer Pricing"), meaning the
attributes completely match between the two use cases.

Attribute Details
Attributes Details report within a Use Case Analysis dashboard is structured as a data table
showing attributes related to financial or business processes.
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Figure 8-115    Attribute Details

The interface consists of two main sections:

Data Table (Attributes Details) – Displays key dataset details:

• Use Case – Business process or scenario

• Grain – Level of data detail

• Entity – Business data objects

• Attribute – Specific data fields (e.g., "Account or Contract Number")

• Usage Type – Classification of attributes (e.g., "Mandatory" means required)

8.1.4.9 Right To Forget
The Right to Forget (RTF) feature ensures that businesses protect sensitive Personally
Identifiable Information (PII) related to party data. This functionality is available in Data
Foundation Cloud Service (DFCS) and involves randomizing party data when it is no longer
needed in the system.

RTF Process Overview

• The RTF process is executed as a PMF job.

• It is user-driven, requiring customers to input Party Identifiers that need to be forgotten.

• Users must provide Party Identifiers through a PMF input, with multiple IDs entered as
comma-separated values.

• Before executing the RTF process, users must invoke the SCD process (DIM Incremental
Process) to update the Party Dimension.

• Only Party IDs present in the Party Dimension will be considered for randomization.

RTF Execution Details

• For each RTF request, the service checks if the user has sensitive PII-related party data
in any entity.
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• If such data exists, the system fetches the list of affected entities and randomizes the PII-
related data.

• The RTF Metadata Registration Table is preconfigured with Party Identifier (Business
Term - BTO3899) for executing the RTF functionality.

RTF Data Visualization Reports

The following RTF-related information can be viewed in Data Visualization (DV) reports:

1. Navigate to the Catalog menu, and open the Catalog application.

2. Click on the Shared Folders tab.

3. Navigate to Data Foundation Reports.

4. Locate the Right To Forget folder in the list and click Sensitive Data Anonymization. For
more information, see Pre-Built Reports.

5. Dashboard Sections:

Figure 8-116    Right to Forget Dashboard

• Customer Request and Status – Displays request details.

• Audit Log – Tracks affected records for accountability.

6. RTF Customer Request Table – Stores details of each RTF request, including:

• Request Identifier – Unique request number.

• Requested Date – Date of submission.

• Requested By – Username of requester.

• Party Identifier – Entity involved.

• Execution Status – Indicates success or failure.

7. Reviewing the Audit Log:

• Party Identifier – Matches request ID.

• Entity Name – Type of entity affected.

• Records Affected – Number of modified records.
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8. Filtering and Searching Requests:

• Use filters (e.g., Date, Requested By, Status) to narrow results.

• Select a request to view details in the Audit Log.

9. Verifying Execution Status & Impact:

• If successful, check affected records.

• If failed, troubleshoot using system logs.

10. RTF Execution Status – Once the RTF Engine PMF process completes, the system logs
the execution status:

• If the Party ID is not found, the system updates the status as Not Available and exits.

11. RTF Audit Log – Maintains execution records at the Entity Level, including:

• Date of execution

• Number of records affected

Post-Execution Considerations

• Once an RTF request is successfully processed, the party data is randomized and
secured.

• To maintain data integrity, users must ensure that the forgotten Party IDs do not re-enter
the system during data loads from multiple sources into DFCS.

8.1.4.10 Custom Attributes
DFCS supports Custom Attributes in out of the box entities. Users can use the Reporting
Configuration window to map the Custom Attributes to these supported entities.

8.1.4.10.1 Custom Attributes Creation
To define a custom attribute in OOB table, complete the following steps:

1. On the DFCS Home page, click the My Profile icon and select Administration.

2. Click Report Configuration.

3. Select the OOB table and click on the Edit icon.

4. Select the attribute based on data type needed like date, numeric or string.

5. Click on the Edit icon in the Attribute mapping window.

6. Select the Attribute name from the dropdown list and click Save.

7. To delete a custom attribute, select the attribute and click on Delete icon.

Note

User cannot Edit or Delete the OOTB dimension, it will display NA flag in the
Dimension Mapping window. The available and mapped flag for Custom Attributes
are displayed in the Attribute Mapping window to show the availability of attributes.

Following are the number of custom attributes by data type that can be defined for existing
OOB entities supported in the current release for Accounts subject area:
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PRESENTATION
ENTITY NAME

NUMERIC
ATTRIBUTES

STRING ATTRIBUTES DATE ATTRIBUTES

Account Dimension 8 10 59

Acquisition Channel
Dimension

5 20 45

Branch Dimension 5 20 45

Business Unit Dimension 5 20 45

Data Source Dimension 5 20 45

Fact Account Grain
Extension

8 30 88

Fact Account
Transactions Grain
Extension

8 30 88

Fact Accounting Entries
Grain Extension

8 30 88

General Ledger
Dimension

5 55 170

Instruments Contracts
Dimension

5 20 45

Ledger Dimension 5 20 45

Legal Entity Dimension 5 20 45

Location Dimension 5 20 45

Organization Unit
Dimension

5 55 170

Party Dimension 5 20 45

Product Dimension 5 20 45

Project Dimension 5 20 45

Dimension 1 20 20 60

Dimension 2 20 20 60

Dimension 3 20 20 60

Dimension 4 20 20 60

Dimension 5 20 20 60

Dimension 6 20 20 60

Dimension 7 20 20 60

Dimension 8 20 20 60

Dimension 9 20 20 60

Dimension 10 20 20 60

Dimension 11 20 20 60

Dimension 12 20 20 60

Dimension 13 20 20 60

Dimension 14 20 20 60

Dimension 15 20 20 60

Note

– Refer to the Oracle® Data Foundation Cloud Service Data Catalog guide for detailed
instructions on all types of Catalog extensions.
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8.1.4.10.2 Custom Attributes Visualization
In order to view the extended custom attributes in a staging table and view their logical names,
user can create a Dataset and generate reports in the Data Visualization using OAS interface
using Create Dataset Option available on top right.

To create a dataset and view the custom attributes in staging tables in the Data Visualization
canvas in DFCS, complete the following steps:

1. On the Home page, click the Create icon and then click Dataset.

2. The Dataset page is displayed.

a. Click Create and select Dataset from the available list.

The Create Dataset window is displayed with the list of available connections.

a. Double click on the DS Connection and the New Dataset page is displayed.

b. From the LHS menu, double click on the Manual Query, the Manual Query button is
displayed.

c. Double click on the Manual Query button, and enter the SQL query under the
Statement window.

d. Click Get Preview Data to preview the data of the entered query.

e. Click Save and the Save Dataset As window is displayed.

f. Enter the Name and Description of the dataset and click OK.

You can view the list of extended columns in the staging table.

Figure 8-117    Custom Attributes Visualization

Figure 8-118    Create Dataset

Chapter 8
Browsing Data Visualization

User Guide
G39682-03
Copyright © 2024, 2025, Oracle and/or its affiliates.

August 20, 2025
Page 80 of 81



Note

Refer to “Data Visualization via Custom Dataset” section of this user guide, for further
details about New Dataset creation.
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9
Key Terms and FAQs

• Adjustment Entry
An entry passed in the Product Processor (PP) to reconcile it with the associated GL for
the amount equivalent to the difference and an entry in the Contra GL Account with the
opposite sign for the same amount.

• Adjustment Entry Floor
If the difference between Source and Target is less than the Adjustment Entry Floor
specified in the definition, the calculated difference is not eligible for adjustment, and the
entry will not be logged in the Adjustment Entry Table.

• Attributed Dimension
A dimension whose members can have other properties or qualifiers known as Dimension
Attributes.

• Dataset
A dimension used for segregating data into different sets according to its use or its source.
For example, to separate actuals data, budget data, and encumbrances data. Other uses
include separating test data from production data and creating separate data sets for
What-if Analysis.

• Dimension
A structure that can be used to categorize business data. A dimension contains members;
it can be hierarchical (you can organize the members into one or more hierarchies), or
non- hierarchical.

• Dimension Attributes
A property or qualifier that further describes a dimension member. An attribute can be a
date, a number, or a character string. For example, the Geography dimension can have an
attribute - Population, that designates how many people live in that area. Each member of
the Geography dimension, therefore, has an associated Population.

• Hierarchy
A structure of dimension members organized by parent-child relationships.

• Global Threshold
Global Threshold is applied at an execution level where all the reconciliation differences for
execution are added and checked across the absolute sum of source balance.

• Inherit to Child
This feature is used to find child legal entities under the hierarchy node of a Legal Entity
that is selected at the definition level. If used while defining the GL Reconciliation rule, all
child nodes will participate in the reconciliation process.

• Reconciliation
Reconciliation is the process of comparing information from one data source to another. An
Account Reconciliation is for a specific period. Reconciliations consist of account balances
(obtained from the Source System for the period) and account properties.

• Reconciliation Difference
Reconciliation difference is the difference in the balance between the Source and the
Target.

• Threshold
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A tolerance level you must set in terms of either the maximum difference allowed in any
single Product Processor and its corresponding GL or the maximum number of Product
Processors having differences in the GL Reconciliation.

• Positive Threshold
These values are used to identify the breach types categorized as Not Breached (NB). The
Breach Type is identified at run time during the reconciliation process, and Audit Trail
entries are posted with this information.

• Negative Threshold
These values are used to identify the breach types categorized as: Negative Percentage
Threshold (NPT), Positive Percentage Threshold (PPT), Negative Absolute Threshold
(NAT), Positive Absolute Threshold (PAT), and Not Breached (NB). The Breach Type is
identified at runtime during the reconciliation process, and Audit Trail entries are posted
with this information.

• Threshold Breached Type
The different types of threshold breaches are listed here.

– PAT - Positive Absolute Threshold

– NAT - Negative Absolute Threshold

– PPT - Positive Percentage Threshold

– NPT - Negative Percentage Threshold

– G - Global

– NB - Notbreached

• General Ledger to Product Processor
General Ledger to Product Processor Reconciliation identifies the difference between GL
system and Product Processor data. It nullifies the difference by posting the adjustment
entries up to the amount of difference.

• General Ledger to Product Management Ledger
In General Ledger to Management Ledger (GL to ML) reconciliation, the difference
between two sources of the Ledger for the same Legal Entity and the Consolidation Type
is identified. This difference is identified at the granularity of the GL code for the selected
hierarchy, the mandatory dimensions, and the selected optional dimensions. Adjustments
are not passed in General Ledger to Management Ledger reconciliation.

• Consolidation Type
Two consolidation types are supported:

– Solo
When a legal entity is selected with consolidation type as Solo, all the exposures of
that particular legal entity are selected for processing. Manual reconciliation definition
can process solo legal entity data.

– Consolidated
When a parent legal entity is selected as Consolidated, all the exposures of that legal
entity and exposure of each level (or levels) of descendant child legal entities (without
intra-group exposures) are selected for processing. In intra-group exposures, the
counterparty is a child descendant of any level. For an intra-group scenario (where the
GL Structure has specific intra-group GL Code in addition to regular GL Codes), intra
GL Codes are considered only from the GL side for processing. Non-Intra is a scenario
where no GL Codes are present for reconciliation definition.

– Inherit to Child
This feature is used to find child legal entities under the hierarchy node of a Legal
Entity that is selected at the definition level. If used when defining the GL
Reconciliation rule, all child nodes will participate in the Reconciliation Process.
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– Manual Reconciliation Definition
In manual reconciliation definition, user input is sought on the GL side and PP side to
determine the course of reconciliation. This is applicable to both GL level and map
level reconciliation. In GL level reconciliation, unique GL codes are identified from the
GL code mapping. At the map level, GL codes do not form a part of the reconciliation
definition. A manual reconciliation definition can be used for a solo or consolidated
legal entity. The reconciliation definition for a consolidated GL, having an intra-group
GL structure, is computed from GL Data and not from PP Data. Therefore, any
account present in the PP but unavailable in GL is not captured in the reconciliation
definition.

– GL Level Reconciliation
In GL level reconciliation, the difference between GL system and Product Processors
Systems at each reconciliation dimension node level within a GL Code is identified.
For manual reconciliation definition, unique GL codes are identified from the GL side. If
it is at the solo level, exposures originating in the legal entity are selected. If it is at the
consolidated level, exposures originating in the selected legal entity and its Child
Entities (with or without intra- group exposures depending on GL Structure) are
selected.

The adjustment entry allocation depends on the reconciliation type selected. In GL
level reconciliation, after a definition is executed, the differences that emerge as a part
of the reconciliation definition (GL–PP level reconciliation) are reported in the
Adjustment Entry Table. This table shows all the entries of an executed map that
requires adjustment. The difference in amount can either be posted to Product
Processors or an external table. For more information on the external table, see the
Data Requirement section.

– Map Level Reconciliation
In map level reconciliation, the difference between GL Data and PP Data at each
reconciliation dimension node level across all PPs is identified. Unlike GL level
reconciliation, map level reconciliation is computed at an aggregate level of the
reconciliation definition; by ignoring the GL code and by considering reconciliation
dimensions. Map level reconciliation is applied at the legal entity level - either solo or
consolidated. If it is at the solo level, then exposures originating in a particular legal
entity are selected. If it is at the consolidated level, then exposures originating in the
selected legal entity and its child entities (excluding intra-group exposure depending
on GL structure) are selected.

The adjustment entry allocation depends on the reconciliation type selected. In map
level reconciliation, after a definition has been executed the differences that emerge as
a part of the reconciliation (General Ledger–Product Processor Level Reconciliation)
are reported in the Adjustment Entry Table. This table shows all the entries of an
executed map that requires adjustment. The difference in amount can either be posted
to Product Processors or an external table. The adjustment allocation can be either
automatic or manual.

9.1 Frequently Asked Questions
You can refer to the Frequently Asked Questions, which is developed with the interest to help
you resolve some of the DFCS Installation and Configuration Issues. This intends to share the
knowledge of problem resolution to a few of the Known Issues. This is not an official support
document and just attempts to share the knowledge of problem resolution to a few of the
Known Issues.

1. What happens when users try to log in during a maintenance period?
When the instance is under maintenance, a “Maintenance Page” is displayed.
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2. What happens for the users that are logged in?
If users are already logged in, all further actions are blocked. On refresh, users are
directed to the Maintenance Page.

3. Can APIs be invoked during maintenance period? No. The API requests are blocked.
No. The API requests are blocked.

4. What happens to ongoing batches?
Batches will continue, however, it is recommended to ensure all processes are completed
before maintenance begins.
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